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1
Introduction

The main purpose of these tutorials is to assist model users in performing hands-on applications of
the OilFlow2D model using QGIS.
OilFlow2D is a two-dimensional model that simulates spreading of crude oils and other viscous
fluids on the land surface, and trajectory and fate of crude oils on water. The oil spill on land module
can simulate oil depths and velocity over irregular surfaces considering fluid properties such as
density, viscosity that can vary in time. The model can use 3 different rheogological formulations for
Newtonian and non-Newtonian fluids that can have yield stress. The OilFlow2D model also accounts
for oil evaporation and that process affects density and viscosity and its subsequent impact on fluid
flow. The oil spill on water module uses a particle-tracking approach to simulate oil trajectories
of oil spill, and includes oil fate algorithms to account for evaporation, emulsification, dissolution,
dispersion, and interaction with shores.
The user interface of Hydronia models is based on QGIS, a powerful software for the analysis
of geographic information systems of free distribution. This software system integrated with GMSH
mesh generation plugin provides interactive functions to generate and refine the finite-volume flexible
mesh, and uses familiar GIS objects to construct a high level representation of the model. QGIS
also offers a complete set of visualization tools that include rendering, for the representation of the
results generated by the model.

1



2
Creating your first river flow application with

OilFlow2D

This section provides a step-by-step guide to help you get started with a OilFlow2D project using
the QGIS interface. The example illustrates the model application to simulate flow in a river with a
single inflow upstream and a single outflow downstream. It includes instructions to enter the terrain
elevation data, create the mesh, prepare the layers with the input information, and run RiverFlow2D.

2.1 Starting a new project
The files required to follow this tutorial can be extracted from the ‘ExampleProjects’ zip file under
the ‘Hoh_QGIS_Metric_Units’ folder. This zip file is downloaded separately from your installation
materials.

Figure 2.1 – Files with data required for the example.

The first step is to start the QGIS software clicking the QGIS desktop icon . If this icon is not
available, you can run the ‘qgis-bin.exe’ executable on the QGIS ‘bin’ subdirectory. After loading,
you will see a window similar to the one shown below:

2



3 2. Creating your first river flow application with OilFlow2D

Figure 2.2 – QGIS interface indicating window areas.

If you don’t see the toolbar with the model icons as shown, you will need to activate the plugin using
the Manage and Install Plugins… command under the Plugins menu.
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Figure 2.3 – Plugins window showing activated OilFlow2D.

2.2 Start a new project

1. To create a new OilFlow2D project, click on the New OilFlow2D Project button in the
toolbar. to start a new OilFlow2D project. A dialog window appears where you select the layers
that will be created, the Coordinate Reference System (CRS), and the directory path where
the layers will be saved. This example will use the basic layers: Domain Outline, Manning N,
and BoundaryConditions

2. Select None in the Layers drop down menu.

3. Select the Projection button. In the Filter textbox, type 2855 and select the Coordinate Refer-
ence System as shown:
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Coordinate Reference System Selector dialog window.

4. Click OK.

5. Select EPSG:2855 that corresponds to the NAD83(HARN)/Washington North Coordinate Ref-
erence System (CRS):

Create New OilFlow2D Project.

6. Click the button to provide a path to store the project files in the Project Directory textbox.
This will be the folder where the model will write all results and output files.
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7. After clicking OK, the layer templates are created, and displayed on the Layers Panel

The model will use the unit system as that defined in the projection you selected. If the pro-
jection has coordinates in feet, units will be set to English. If the projection coordinates are in
meters, units will be set to Metric/SI.

Layers created for the project.

8. On the QGIS Project menu, click Save, to save the project in the same directory that you
previously selected in the Create New Project dialog above.

2.3 Load elevation data
In this tutorial we will use a raster file that contains the terrain and river bed bottom elevation data
in ASCII grid format.

1. To load an ASCII grid file, click the Add Raster Layer button .

2. In the dialog search for the tutorial folder and select the ‘hohdem2.tif’ file as shown:

Dialog to create a layer from a raster file.

3. While on the dialog, click Add and click Close.

4. Use the Zoom to Layer button to center the image.

Once the process is completed, the raster will be displayed on the screen, by default it is
rendered in gray gradient as shown.
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Digital elevation model in raster format.

Right-clicking on the label of the new raster layer and selecting Properties allows you to change
the rendering style for a more informative palette such as Hillshade for instance.

Window to change the raster layer render style.

And now the raster layer is displayed with the new palette selected:
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Digital elevation model with Hillshade render.

5. You should move the raster layer dragging it to the end of the list of layers to avoid that it would
hide or interfere visually with the other layers.

2.4 Create the limits of the modeling area

We define the limits of the modeling area drawing a polygon on the Domain Outline layer. To create
it do as follows:

1. Click the Domain Outline layer to activate it and then click Toggle Editing (pencil) in the toolbar

2. This activates the rest of the editing buttons. Now click the Add Feature tool which is the

bean-looking polygon .

Proceed to delineate the outline of the polygon by clicking the vertices with the left mouse
button.

Make sure that the polygon is contained within the limits of the raster layer since the program
will not extrapolate elevations to areas that are outside of the available data on the raster layer.

3. To finalize and close the polygon, right-click on the map view area. A dialog window to input
the cell size attribute of the newly created polygon will appear. The CellSize value for the
reference size of the mesh cell is indicated. Enter a value of 20 m.
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CellSize defined for the Domain Outline layer.

If you want to make any correction in the outline of the created polygon, use the Node Tool

.

4. Save the polygon by clicking the Save button .

5. and click on Toggle Editing button to deactivate the layer Edit mode

The Domain Outline is now complete.

Figure 2.4 – Domain Outline layer.

2.5 Generating the triangular-cell mesh
Now that the Domain Outline layer has been created, proceed to create the mesh by clicking on the
Generate Trimesh button
The following figure shows the generated mesh. You will also see in the Layers panel the new layer:
Trimesh
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Figure 2.5 – Resulting mesh.

You can see the mesh generation statistics, and other messages produced by the mesh generation
program while creating the mesh in the Log messages panel. This window is accessed from the
View menu, then by clicking Panels.

Figure 2.6 – Message panel of the registry with GMSH messages.

2.6 Setting up the boundary conditions
Inflow boundary conditions:

1. Select the BoundaryConditions layer in the Layers panel.
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2. Click the Toggle Editing button to add the polygons that will indicate the open boundary
segments where inflow and outflow conditions are imposed. Draw a polygon at the upper end
of the mesh as indicated in the figure:

Polygon that covers the nodes defining the Inflow boundary condition segment.

3. To finish the polygon, right-click on desired location. A window to enter the attributes of the
newly created polygon is displayed.

4. In the Boundary Cond. ID enter the desired name or leave the default.

5. From Type of Open Boundary list, select 2. Discharge vs. Time

6. Click Import BC File button, and search for the ‘QIN.DAT’ hydrograph file as shown below:

Inflow boundary condition parameters.

Hydrograph loaded from the ’QIN.DAT‘ file.

7. Click OK to close the dialog and then click Save .
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Outflow boundary conditions:

1. Draw the polygon defining the outflow boundary condition at the downstream end of the chan-
nel as shown.

Polygon that defines the outflow boundary condition segment.

2. Right click to close the polygon. A dialog window will appear to enter the parameters. Select
the condition type Uniform flow conditions and enter the channel slope. Slope is entered in So
as shown:

Parameters for the uniform flow outflow open boundary condition.

3. Save the changes made to the layer by clicking the Save button .

4. Deactivate editing mode by clicking on the Toggle Editing button .

The figure below shows how the BoundaryConditions layer should look:



13 2. Creating your first river flow application with OilFlow2D

Polygons that define the inflow and outflow boundary conditions.

2.7 Assigning Manning’s n

To assign Manning’s n values, we enter polygons with given n’s. There can be as many polygons
as those required to reproduce the spatial variability of this parameter. In this example, a single
polygon will be drawn for the entire area.

1. Select the Manning N layer and click the Toggle Editing button

2. Draw a polygon that covers the entire domain. The polygon may extend beyond the mesh area
as shown:
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Capa Manning N.

3. Close the polygon by right-clicking on the end vertex and enter a Manning’s n equal to 0.035:

Diálogo para ingresar ManningN.

4. Click Save , and then click the Toggle Editing button to deactivate editing mode.

Save the QGIS project using the Save command in the Project menu. Name the project file ‘Hoh.qgs’.

2.8 Exporting the files
Once the layers with the input data to the model have been created, we need to export data files
required to run RiverFlow2D.
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1. In the RiverFlow2d plugin toolbar, click the Export files for RiverFlow2d button and select
Export RiverFlow2d …

2. In the export dialog window indicate the Scenario Name and the raster layer of the Digital
Elevation Model (DEM).

The Scenario name is also the name that will be given to all of the exported files, these names
should never be changed manually.

3. Click OK.

Export dialog.

A message at the top of the Map area shows the progress of the Export process.

Once the model files have been created, the Hydronia Data Input Program will appear auto-
matically with the main control data file loaded, in this case: ‘Hoh.DAT’.

Once the model files have been created, the Hydronia Data Input Program will appear auto-
matically with the main control data file loaded, in this case: ‘Hoh.DAT’.

Hydronia Data Input Program window.

4. Click the Run RiverFlow2D button to run the model.

5. A Dialog box will ask if you want to save changs, no changes were made so select [No].

An image similar to the one shown below should appear:
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Window displayed while the model runs.

Take some time to explore the information included in this window.
This concludes the Creating your first RiverFlow2D application tutorial.
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Multiple Scenario Project Tool

When establishing a mathematical model of a system, it is very common to perform a variety of
runs with different values of the most significant parameters to see their effects. In some cases, it
is also useful to have the model run the scenario without a project and within a project. In previous
versions of the plugin this had to be done in separate QGIS projects, which involved making copies
of the project folders and data, which can bring problems with data handling and access. This new
version of the RiverFlow2D plugin for QGIS allows the management of multiple scenarios within the
same project. In this way variants of the same model can be created as subprojects, thus bringing
with it the advantage of having all the variants organized in the same project which facilitates access
and management of information. The following describes the new features of the QGIS interface
for RiverFlow2D that allow the handling of multiple scenarios.

3.1 New interface elements for managing multi-scenario
projects in RiverFlow2D

This section provides a description of the new elements in the QGIS user interface for handling
RiverFlow2D multi-scenario projects. The RiverFlow2D toolbar now features three new items:

• A drop-down list that shows the user the list of scenarios contained in the project.

• An option to generate new scenarios in the New RiverFlow2D Project button.

• An option in the RiverFlow2D tools menu that allows you to import an existing RiverFlow2D
project into the multi-scenario mode.

The figures below show the three new elements.

17
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Figure 3.1 – Drop-down list for displaying and selecting project scenarios

Figure 3.2 – Tool to create a new scenario within the project

Figure 3.3 – Tool to convert existing project to multi-scenario

3.2 Creating a new RiverFlow2D multiple-scenario
project using QGIS

• To create a new project into a multi-scenario project, access the first button on the toolbar and
select the New RiverFlow2D Project menu option as shown in the figure below:

Figure 3.4 – Menu to create a new project

The dialog window a field is presented to indicate the name of the initial scenario (highlighted in a
red box in the figure below), by default this field is labeled base. The drop-down list for displaying
scenario names is limited in length, we recommend that you assign short names to scenarios for
ease of viewing and to assign names without spaces.
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Figure 3.5 – Dialog window to create a new RF2D project

When creating a multi-scenario project, within the folder selected for the project a subfolder is cre-
ated with the name given to the initial scenario, (in this example the folder name base)and within that
sub-folder another subfolder is created with the name shape where QGIS creates the templates of
the layers used by the model for that scenario. Each other scenario will have its own shape subfolder
that contain the layers for that particular scenario.

3.3 Create a new scenario
Once we have a project created with the new Multi-scenario tool, we can start to create additional
scenarios by following the steps in this section. Please make sure to have either created a new
project with the tool or have already converted an existing project before doing the following.

• To create a new scenario, access the first button on the toolbar and select the New Scenario
menu option as shown in the figure below:
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Menu for creating a new scenario in an RF2D project

• A window will be presented, input the scenario name keeping in mind to use short names
without spaces.

Window to create a new scenario.

The new scenario is based on the layers with the input data of the current scenario. The plugin
will proceed to create a subfolder with the name of the new scenario within the project folder. In
this folder the files corresponding to the layers of the RiverFlow2D project will be copied with
the input geospatial information it requires. Please note that the model layers will not copy
post-processing products such as maps or animations. The plugin then updates the paths of
the sources of the layers to the files in the new folder and finally the drop-down list in the RF2D
toolbar is updated with the name of the new scenario.

3.4 Switching scenarios
• To switch between the different scenarios that you have in a project, simply display the scenario

list located in the RF2D toolbar and select the desired scenario as shown in the following figure:

Switching scenarios
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• Then a Dialog window will ask for confirmation to switch scenarios, as shown in the figure:

Confirmation window for switching the scenario.

When you switch scenarios, the state of the layers in the current scenario is automatically
saved.

3.5 Deleting scenarios
To safely delete scenarios, the tool also contains a menu option to delete them when needed:

• Use the button below the New RiverFlow2D Project dropdown, and select Delete Scenario:

Figure 3.6 – Menu button to delete a scenario.

*IMPORTANT* Please note that deleting a scenario folder manually from the project directory will
cause the entire project to be unusable. This tool must be used in order to avoid this.

3.6 Import an RiverFlow2D project into Multi-scenario
mode

The RiverFlow2D Multi Scenario tool has a feature that allows you to import an existing project(mono-
scenario) and convert it to a maulti-scenario project.

• Open this tool in the options menu of the RF2D Tools button as shown in the figure below:

Menu to import a project to multi-scenario mode
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• When you start the import tool a window is displayed as illustrated in the figure below, you
must specify the project file. DAT to import.

Import tool window

• Once you click [OK], a subfolder with the name of the file is created inside the folder where
the original project is located.

• All files and sub directories in that main project folder are copied, and the metadata of the
project QGZ is updated with the new location of the layers.

• Finally the drop-down list on the RF2D toolbar is updated with the name of the new scenario.

The files of the original project are kept in the project folder, it is at the discretion of the user delete it if
you think it necessary, the only one that is required then is the QGIS project file (.qgz) This concludes
the tutorial on using the Multiple Scenario Project tool within the QGIS RiverFlow2D toolbar.



4
Simulating levees using weirs

This tutorial illustrates how to incorporate a levee to an existing RiverFlow2D project using the Weirs
Component in the QGIS interface. The problem consists in modeling a lateral weir along the right
margin of a river, as can be seen in the following figure:

Figure 4.1 – The weir polyline representing the levee is shown in red.

The procedure to incorporate the weir in a RiverFlow2D simulation involves the following steps:

1. Open an existing RiverFlow2D project.

2. Add the Weirs layer.

23
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3. Draw the weir polylines.

4. Input the weir parameters or attributes.

5. Export the files to RiverFlow2D.

6. Run the RiverFlow2D model.

7. Review the output files.

The files required to follow this tutorial can be extracted from the ‘ExampleProjects’ zip file under
the ‘WeirTutorial’ folder. This zip file is downloaded separately from your installation materials.

4.1 Open an existing project
1. Open QGIS.

2. On the Project menu click Open… and browse to select the existing project: .

This project contains the following layers: Domain Outline, Digital Elevation Model (DEM) of
the river bed in raster format, aerial photography, polygon with the Manning coefficient and the
polygons with the boundary conditions where the flow entrance is in the upper left corner and
exit in the lower left corner. The boundary conditions are a hydrograph with a peak discharge
of 220,000 ft3/s, and outflow condition is set to uniform flow. When you open the project you
will have a project image loaded in QGIS as shown in Figure 4.2:

Example of the tutorial loaded in QGIS.

4.2 Create a Weirs layer and the weir polyline
The weir location can be drawn on the Weirs layer or it can be imported from an existing file. In
this tutorial, the polyline that indicates the location of the weir will be imported from a text file. The
structure of the file should be as follows:

• The first line must indicate the number n of nodes that contains the polyline.



25 4. Simulating levees using weirs

• The n successive lines will contain three columns with the X, Y coordinates.

• The elevation of the weir crest separated by space as shown in Figure 4.3:

Figure 4.2 – Text file with weir alignment data.

Adding the Weirs layer involves the following steps:

1. Create Weirs layer: for this click on the New Template Layer button in the RiverFlow2D toolbar

2. Activate the checkbox Weirs, as shown in the Figure below:

Plugin to add a new template layer.

3. Edit the Weirs layer: In the layer panel, select the Weirs layer and in the digitalization toolbar
click on the Toggle Editing button
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A pencil icon will appear in the Weirs layer indicating that the layer is in edit mode:

4. Draw the line representing the weir: Using the Add Feature tool from the digitalization bar

Draw a line anywhere in the map area (just mark two vertices or nodes. This line will then be
replaced by the coordinates of the file to be imported).

5. Right-click to finish the layout and a dialog window will appear to input the weir parameters.

6. Input the weir parameters: The window to input the weir attributes contains two tabs. In the
first one there are the fields of the general parameters, within which has:

• Weir Name (ID): Weir1

• Weir discharge coefficient: 3.2

• Weir crest elevation for all the weir: since a file will be imported this field will be left empty.

• Size Element: 150

• Import Geometry File: Click the […] button and point to the file LeveeRB_Breakline.txt
which is found in the tutorials folder.

The weir parameters window should look like the image shown below:

Window to input Weir parameters.

In the second tab ‘Weir crest elevation for vertex’ the data contained in the file LeveeRB_Breakline.txt
is displayed, as shown in the following Figure:
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Window for weir geometry data.

7. Then click on the [OK] button.

8. Save the changes in the layer using the Save button of the digitalization toolbar

9. Disable the editing mode of the layer with the Toggle Editing button

and we will have on screen an image similar to the one shown below where you can see the
layout of the weir:

Weir alignment loaded from the file.

4.3 Generate the mesh
The mesh is generated with the Generate TriMesh plugin.
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result should look similar to the image on Figure 4.8.

Figure 4.3 – The mesh generated.

4.4 Exporting files to RiverFlow2D

Now that you have generated the mesh and you have the other layers ready with the necessary
data, you should export the files in the format required by RiverFlow2D.

1. Click the Export to RiverFlow2D button.

2. When running the plugin a window is displayed, here we must select the raster layer that
contains the Digital Elevation Model (DEM) and the name of the project to be exported.

Once the plugin is executed, a window will be shown (Figure 4.9), as it should be for our
example.
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Plugin window to export the files to RiverFlow2D.

3. After inputting the data, click on the OK button and the export process will begin. Once it is
finished, Hydronia Data Input Program will be loaded as shown in Figure 4.10

Control data panel.

4.5 Running the model

Make sure that the Weirs Component appears selected in the Control Data panel.

1. In the list of components, select ‘Weirs’ and the panel of the Weirs component will appear.
In this window the contents of the ‘.WEIRS’ file content as prepared by RiverFlow2D will be
displayed (Figure 4.11).
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Weirs component data panel.

2. Leave all other parameters at their default values.

3. Click on the Run RiverFlow2D button in the lower section of Hydronia Data Input Program.
A window will appear indicating that the model began to run. The window also informs the
simulation time, the volume conservation error, the total input and output discharge and other
parameters as the execution progresses (Figure 4.12).

RiverFlow2D output graphics.

4.6 Review the output files
RiverFlow2D creates an output file with the name of the project and extension ‘.WEIRI’ for metric
units and ‘.WEIRE’ for English units. The files report results for each weir and for each output
interval. Output includes the following information:
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• EDGE: The segments into which the weir is divided and is given by the length of the cells in
contact with the weir.

• N1 y N2: The numbers that identify the cells that share the EDGE segment in the weir.

• WSE1 y WSE2: The elevations of the water surface in the cells indicated by N1 and N2.

• D1 y D2: The depths of the flow in the cells indicated by N1 and N2.

• Distance: The length of the EDGE segment.

• Q: The discharge that passes through the EDGE segment.

The ‘.WEIRE’ file contains the following:

Figure 4.4 – Extract of the output file of the Weir1.



4.6 Review the output files 32

This concludes the Simulating Levees using Weirs Tutorial.



5
Simulating bridges

This tutorial illustrates how to incorporate a bridge into an existing RiverFlow2D project using the
Bridge Component through the QGIS interface. The procedure involves the following steps:

1. Create the bridge geometry data.

2. Open an existing RiverFlow2D project.

3. Enter the bridge polyline.

4. Enter the bridge data.

5. Generate the mesh.

6. Export the files of RiverFlow2D.

7. Running the model.

The files required to follow this tutorial can be extracted from the ‘ExampleProjects’ zip file under
the ‘BridgesTutorial’ folder. This zip file is downloaded separately from your installation materials.

5.1 Create a bridge geometry file
Integrating bridges in RiverFlow2D requires preparing the bridge cross section geometry data prior
to running the model. With the QGIS interface you have the option of creating a simplified bridge
geometry from the terrain profile obtained from the digital elevation model, and then you can use
the Bridges panel in the Hydronia Data Input Program to perform the adjustments necessary to the
geometry generated by QGIS. This option is useful when the bridge is located on a natural section
of the river, and the geometry of the bridge is simple (Figure 5.1a). However, other cases may

33



5.1 Create a bridge geometry file 34

involve more complex bridge geometries (Figure 5.1b), that require a more detailed preparation of
the bridge geometry file.

Figure 5.1 – Bridge geometries.

Figure 5.2 shows the front view of the bridge that you will to incorporate into the model for this tutorial.
The data is also in the file ‘BRIDGEGEOMETRY.DAT’ contained in the directory of this tutorial.

Figure 5.2 – Front view of the bridge.

It represents the cross section of a bridge with only one central pier, although this is just for the
purpose of illustrating the Bridges component in this tutorial since the actual bridge in this location
has about 12 sets of piers. This geometry is represented in the RiverFlow2D model using the bridge
geometry file shown below, where the header row is presented only to describe the parameters, and
they should not be included in the actual data file:



35 5. Simulating bridges

Figure 5.3 – Data of the bridge geometry.

You may use the Bridges panel in Hydronia Data Input Program to create to some extent, or edit a
bridge geometry file (see Figure 5.4). The program lets you enter data in tabular form and view a
graph of the bridge geometry. You may also manipulate the graphical lines, which will make that the
tabular data be modified.

Figure 5.4 – Bridges panel.
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An alternative way to create the bridge geometry file is to use a spreadsheet. In the folder for this
tutorial there is a MS-Excel sheet (‘BridgesGeometryPlot.xlsx’) that allows editing and plotting bridge
geometry files.

5.2 Open an existing project
1. On the Project menu click Open… to load the existing project: .

This project contains the layers of the domain contour, the Digital Elevation Model DEM of the
river bed in raster format, the polygons with the Manning’s n for the different land coverages,
an aerial image, and the boundary conditions. Inflow is located in the upper right segment,
and outflow in the lower left. The boundary conditions are a hydrograph with a peak discharge
of 220,000 ft3/s (cfs), and outflow condition is set to uniform flow. When you open the project
you will have an image of the project loaded in QGIS as shown in Figure 5.5.

Project screen loaded in QGIS.

5.3 Enter the bridge polyline in the Bridges layer
This step ensures that the mesh will conform to the bridge alignment, so that there will be nodes
generated along the bridge. In this case we will enter the bridge is a straight line approximately 1740
feet long as follows:

1. Create a new Bridges layer: for this, go to the RiverFlow2D toolbar and left click on the New
Template Layer button
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In the plugin window we activate the Bridges checkBox, as shown in the Figure below.

RiverFlow2D dialog to add new layer.

2. Edit the Bridges layer: In the layers panel we select the Bridges layer then in the digitalization

toolbar we left click on the Toggle Editing button .

A pencil icon will appear in the Bridges layer that tells us that the layer is in edit mode:

3. Draw the line representing the bridge: (if necessary, turn off the DEM layer so that it does not
interfere with the identification of the bridge site in the aerial photograph).

4. Using the Add Feature button of the digitalization toolbar , draw the line indicating the
location of the bridge. In the case shown, to demarcate the line that indicates the location
of the bridge. It is only necessary to indicate two vertices (initial and final), then right-click to
finish the drawing.

We will have an image similar to the one shown in the following figure:
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Bridge drawing.

5. Enter the bridge data: After the bridge layout is finished, the window to input the attributes of
the bridge is immediately displayed, these are:

• Bridge Name (ID): Bridge1
• Size Element: 150 feet
• Click on the [Import Geometry Bridge File] button to select the Bridge file: BRIDGEGE-

OMETRY.dat in the Data folder of this tutorial.
• Elevation of the lower bridge deck (LOWCHORD): 138
• Elevation of the bridge deck (DECKELEV): 142

The figure below shows the attributes window of the Bridges layer:

Attribute dialog window of the Bridges layer.

6. After entering the values, click on the [Check Fields] button, then click the [OK] button.

7. Save the changes in the layer using the save button of the digitalization toolbar:
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and disable the editing mode of the layer with the Toggle Editing

5.4 Generate the mesh
The mesh is generated with using the RiverFlow2D emphGenerate TriMesh icon:

Check that the resulting mesh is perfectly aligned with the bridge as shown in Figure 5.9.

Figure 5.5 – Mesh aligned with bridge polyline.

5.5 Exporting files to RiverFlow2D
Now that you have generated the mesh, and you have the other layers with the necessary data
ready, you should export the files in the format required by RiverFlow2D.

1. Click on Export RiverFlow2D button:

In the export files dialog we need to make sure that the appropriate raster layer corresponding
to the Digital Elevation Model (DEM) is selected. The Project Name will already be set.

The dialog should look as follows:
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Export RiverFlow2D tool.

2. Click on the [OK] button and the export process will begin.

Once finished, the Data Input Program will be loaded with the ‘.DAT’ file of the specific example.

5.6 Running the Model
After exporting the files, the RiverFlow2D program is loaded with the project file of the ‘bridge.DAT’
example, and the Control Data panel is shown (Figure 5.11).

Figure 5.6 – Control Data panel.

Select the Bridges panel to review the contents of the bridge geometry file (Figure 5.12). Note how
the bridge profile was discretized every 150 feet according to the element size imposed to the bridge
line.
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Figure 5.7 – Bridges component data panel.

Leave all other parameters at their default values.
To run the model, click on the Run RiverFlow2D button in the lower section of Hydronia Data Input
Program. A window will appear indicating that the model run started. The window also reports
the simulation time, the volume conservation error, the total input and output discharge, and other
parameters as the execution progresses (Figure 5.13).

Figure 5.8 – RiverFlow2D output graphics.

Once this process completes, check the outputs in the scenario folder to review the ‘BridgeTuto-
rial.bridgeh’ file:
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Figure 5.9 – Bridge hydrograph file ’.bridgeh‘.

This concludes the Simulating bridges tutorial.



6
Simulating culverts

This tutorial shows how to incorporate culverts in an existing RiverFlow2D project using the QGIS
interface. The problem consists of a natural channel crossed by a road embankment. A culvert
structure is to be used to connect the upstream and downstream parts of the channel divided by the
embankment as shown in the following figure:
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Figure 6.1 – Culvert scheme.

The water enters from upstream with a constant discharge of 1000 cfs, and outflows downstream
along the indicated section. The area is initially dry. The culvert has a circular cross section, and
other characteristics as summarized in the following Table (CulvertA). CulvertB data is provided in
case that you wanted to extend the tutorial adding a second culvert to the project.

Parameter Description Culvert A
Culvert B
Nb

Number of
identical
barrels 1 1

Ke Entrance
Loss Coef-
ficients

0.5 0.7

n Manning’s
n
Coefficient

0.014 0.015

Kp Inlet
Control
Coefficient

0.3 0.4

M Inlet
Control
Coefficient

2 2

Cp Inlet
Control
Coefficient

1.28 1.1
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Parameter Description Culvert A
Culvert B
Nb

Number of
identical
barrels 1 1

Y Inlet
Control
Coefficient

0.67 0.69

m Inlet
Control
Coefficient

-0.5 -0.5

Dc Diameter
(feet)

3 2

- Inlet
Inverted
elevation

-9999 -9999

- Outlet
Inverted
elevation

-9999 -9999

The procedure to integrate this culvert into a RiverFlow2D simulation involves the following steps:

1. Open an existing RiverFlow2D project.

2. Add a Culvert component layer.

3. Draw the line of culvert alignment.

4. Input the data or attributes for the culvert.

5. Export the files to the RiverFlow2D program.

6. Running the model.

7. Review culvert output files.

The files required to follow this tutorial can be extracted from the ‘ExampleProjects’ zip file under
the ‘CulvertTutorial’ folder. This zip file is downloaded separately from your installation materials.

6.1 Open an existing project
1. Open QGIS.

2. On the Project menu click Open… and browse to the existing project: .

This project contains the following layers: Domain Outline, Digital Elevation Model (DEM) in raster
format, polygon with the Manning’s n coefficient, and the boundary condition polygons. The inflow
is located in the upper left, and the outflow in the lower left. The boundary conditions corresponds
to a constant discharge of 1000 ft3/s, and outflow conditions is set to free. Figure 6.2 shows the
opened project.
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Figure 6.2 – Example of the tutorial loaded in QGIS.

6.2 Create Culverts layer and draw the culvert
1. To create the Culverts layer, in the RiverFlow2D toolbar click on the New Template Layer icon

2. In the window select the Culverts checkBox, as shown:

Plugin to add a New Template Layer.
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3. Edit the Culverts layer: In the layers panel select the Culverts layer and in the digitalization
toolbar click on the Toggle Editing button

A pencil icon will appear in the Culverts layer indicating that the layer is in edit mode:

4. Draw the line representing the culvert alignment: Using the tool Add Feature from the digital-
ization toolbar

draw the line that represents the culvert. It is only necessary to indicate two vertices.

5. Right-click to finish drawing. You should get an image similar to the one shown in the following
Figure:

Culvert alignment.

6. Enter the culvert data: After the culvert drawing is finished, the window to input the culvert
attributes immediately appears. The dialog window has 2 tabs, in the General tab you enter
the basic data for circular and box culverts:

• Culvert Name (ID): CULVERT_1,

• Type of culvert: Type 3 (Circular culvert)

• The rest of the parameters are coefficients that needed to compute the culvert discharge.
To help with the introduction of these parameters, the window presents a list with default
values for different types of culverts. If one of the values of the list parameters is not
appropriate, you can choose the option where the value is defined by the user (user
defined). The window of the culvert parameters should be similar to the one shown in the
Figure below:
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Window to input Culvert parameters.

7. After inputting the values, click on the OK button.

8. Save the changes in the layer using the Save button of the digitalization toolbar

9. Disable the editing mode of the layer with the Toggle Editing button

6.3 Generate the mesh

The mesh is generated with the Generate Trimesh tool

the results obtained as shown in Figure 6.6.
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Figure 6.3 – Final mesh.

6.4 Exporting files to RiverFlow2D
Now that you have generated the mesh and you have the other layers ready with the necessary
data, you should export the files in the format required by RiverFlow2D.

1. Click the Export RiverFlow2D button

2. The raster layer that contains the Digital Elevation Model (DEM) and the name of the scenario
should already be set.

A window will appear as shown in (Figure 6.7).

Figure 6.4 – Plugin window to export the files.
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Once done reviewing, click on the [OK] button and the export process will begin. Once finished
processing, the RiverFlow2D program will be loaded with the ‘CulverTutorial.DAT’ file.

6.5 Running the model
After exporting the files, the RiverFlow2D program is loaded with the project file from the ‘Culvert-
Tutorial.DAT’ example and shows the Control Data panel to it as illustrated in Figure 6.8.

Figure 6.5 – Control data panel.

Note that the Culverts Component appears selected. On the left side of the Control Data panel, in
the list of components select Culverts to activate the Culverts panel. The contents of the culvert file
prepared by QGIS will be displayed (Figure 4.10).

Figure 6.6 – Culverts component data panel.
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Leave all other parameters at their default values.

To run the model, click on the Run RiverFlow2D button in the lower section of Hydronia Data Input
Program. A window will appear indicating that the model began to run. The window also reports the
simulation time, volume conservation error, total input and output discharge, and other parameters
as the execution progresses (Figure 6.10).

Figure 6.7 – Runtime graphics.

6.6 Review culvert output file

For each culvert, RiverFlow2D creates an output file called: ‘CULVERT_culvertID.out’, where ‘cul-
vertID’ is the name (ID) entered when we created the culverts. Output includes the series of dis-
charge versus time through the culvert and the elevations of the water surface at the inflow and
outflow locations. For this tutorial, you will find a file called ‘CULVERT_CULVERT_1.out’, whose
content is shown in the following figure:
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Figure 6.8 – Culvert1 output file.

This concludes the Simulating culverts tutorial.
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Simulating dam breaches

This tutorial illustrates how to incorporate dam breach simulation into an existing RiverFlow2D
project using the QGIS interface. The exercise consists of modeling the a dam break flood. The
dam is approximately 1575 feet long, the breach center is 550 feet from the right margin of the dam,
the opening of the breach has the final dimensions shown in the following Figure, a top width of 160
feet, and at the bottom width of 100 feet, the final breach height is 30 feet.

Figure 7.1 – Final dimensions of the dam breach.

For this exercise, a file with the time evolution of the breaching dimensions is required, this file can
be prepared before setting the model or it can be created when entering the input the parameters.
The procedure to model the dam break involves the following steps:

1. Open an existing RiverFlow2D project.

2. Create a DamBreach layer and to draw a line that represent the transverse axis of the dam.
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3. Generate the mesh.

4. Run the model.

5. Review the output files.

The files required to follow this tutorial can be extracted from the ‘ExampleProjects’ zip file under the
‘DamBreachTutorial’ folder. This zip file is downloaded separately from your installation materials.

7.1 Open an existing project
1. Open QGIS

2. On the Project menu click Open… and browse to the existing project: .

This project contains the Domain Outline layer, the digital elevation model DEM of in raster format,
outflow conditions are set to free outflow in the lower left, and an initial condition of water surface
elevation behind the dam. Figure 7.2 shows the project in QGIS.

Figure 7.2 – Project loaded in QGIS.

7.2 Create the DamBreach layer and draw the line that
defines the dam

Creating the dam involves the following steps:
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1. Create the template for the DamBreach layer: in the RiverFlow2D toolbar click on the New
Template Layer button

2. In the dialog select DamBreach, as shown in the figure below:

Dialog to add a new layers.

3. Edit the DamBreach layer: In the layers panel, select the DamBreach layer.

4. In the digitalization toolbar we click on the Toggle Editting button

A pencil icon will appear in the DamBreach layer, indicating that the layer is in edit mode:

5. Draw the line that defines the axis of the dam: Using the Add Feature tool of the digitalization
toolbar
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6. Draw the line that defines the dam axis. Keep in mind that the breach centroid is measured
from the first vertex of the dam line. In this example it occurs 550 feet from the left margin
of the dam (Figure 7.1). The dam axis is drawn from the top of the channel (point v0) to the
bottom (point v1) along one side of the polygon that defines the initial water surface elevation,
as illustrated in the image below.

Dam axis.

7. Once finished drawing the dam axis, the window to input the parameters of the DamBreach
appears.

8. Input the information as seen below in the figure and click the Check Fields button:

Dialog to input the dam breach parameters.

9. Click the Temporal evolution tab and click on the Import Dam Breach File button. Select the
‘DAMBREACH_1.txt’ file in the scenario folder. Click OK to close.

10. The temporal evolution of the ‘DAMBREACH_1.TXT’ file is shown in the Temporal evolution
tab below:
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Evolution of the breach of the dam.

Dam axis.

7.3 Generate the mesh

The mesh is generated using the Generate TriMesh tool

Figure 7.8 shows the resulting mesh of almost 11,000 cells
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Figure 7.3 – The resulting dam breach mesh. Detail show mesh along the dam axis.

7.4 Exporting files to RiverFlow2D
1. Click on the Export RiverFlow2D button.

2. Select the raster layer that contains the Digital Elevation Model (DEM) and the name of the
project.

Export dialog.

3. Once finished, click on the OK button and the export process will begin. Once it is finished,
RiverFlow2D will be loaded with the ‘base.DAT’ file.
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7.5 Running the model
After exporting the files, Hydronia Data Input Program is loaded with the project file of the ‘base.DAT’
example and shows the Control Data panel as illustrated in Figure 7.10.

Figure 7.4 – Hydronia Data Input Program.

It can be seen that the Dam Breach component is selected as well as the initial condition that
indicates that the initial elevation of the water surface of the ‘.FED’ file will be read. Selecting from
the list on the left panel the Dam Breach component will show the panel where you can see the
parameters of the dam breach as shown in the figure below:

Figure 7.5 – Dam Breach component.

1. Before running the model, set the simulation time to 4 hours.

2. Leave all other parameters at their default values.
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3. To run the model, click on the Run RiverFlow2D button in the lower section of Hydronia Data
Input Program.

4. Save the changes with the same name as the ‘DamBreach.DAT’ file.

A window will appear indicating that the model has started running. The window that RiverFlow2D
presents while running the model shows simulation time information, volume conservation error, the
total input and output discharge as well as other parameters as execution progresses (Figure 7.12).

Figure 7.6 – RiverFlow2D output graphics.

7.6 Review the output files

RiverFlow2D output the dam breach hydrograph in a file with extension ‘.dambreachh’. Figure 7.13
shows a section of that file for this exercise.
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Figure 7.7 – Extract of the ’DamBreach.dambreachh‘ file

This concludes the Simulating dam breaches tutorial.
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Establishing initial water, mud, or tailings

elevations

Sometimes it is practical to use a raster layer to establish the initial condition of the water surface
elevation (Initial WSE). For instance, when modeling tailings dam breaks, it is often necessary to
define the initial surface of the tailings behind the dam.
This tutorial illustrates how to use a raster file that contains the initial elevations of the fluid contained
by a dam with the purpose of simulate a dam breach and determine the fluid runout after the dam
collapses.
The procedure of modeling a dam-breach using an initial condition of fluid surface elevation involves
the following steps:

1. Open an existing RiverFlow2D project.

2. Import a raster layer with the initial values of the water surface elevation (WSE).

3. Export the files to RiverFlow2D by setting the option to use the raster layer with the Initial WSE.

The files used in this tutorial can be found in the following directory:
‘Documents\Hydronia\RiverFlow2D\ExampleProjects\initalWSE_RasterTutorial’

8.1 Open an existing RiverFlow2D project
Start QGIS and in the Project, use the Open… command to load the existing project: ‘Initial-
WSE_RasterTutorial.qgs’. The project corresponds to a model of a dam breach with an initial el-
evation of the fluid surface that is not horizontal but varies in space.

62



63 8. Establishing initial water, mud, or tailings elevations

When you open the project you will have an image of the project loaded in QGIS as shown in the
Figure 8.1.

Figure 8.1 – Project screen loaded in QGIS.

8.2 Importing the Initial WSE raster layer

The procedure to import the Initial WSE raster layer to the project includes the following steps:

1. Open the ASCII grid file representing the initial condition elevations clicking on on the Add

Raster Layer button and selecting the ‘InitiaWSE_r.tif’ file.

2. Confirm the CRS 2229 projection that will be used for this layer

3. If necessary, move the new layer under the group MESH_SPATIAL_DATA. You should have
an image on the screen like the one shown below:
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Initial WSE raster layer.

The image shows the InitialWSE_r raster layer in grays gradient where there is a change in
the WSE ranging from 135.0 to 135.4 ft.

The window above has the Trimesh layer disabled for clarity. Re-enable it for the export pro-
cess in the next section.

8.3 Exporting files to RiverFlow2D

1. Export the files in the format required by the RiverFlow2D using the Export to RiverFlow2D
plugin. When executing the plugin a window like the one shown in the Figure 8.3 is shown.
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Plugin window to export the files to RiverFlow2D.

As shown in the figure, click the Options arrow to display the group of options that appear
hidden by default.

2. Select the DEM raster in the DEM (Single Raster) drop down.

3. Check the box Using Initial WSE Raster Layer. Select the InitialWSE_r layer from the drop-
down list.

4. Click OK button and the export process will begin.

From this point on, You can refer to the Dam Breach tutorial to continue with the modeling of the
dam breach.
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Simulating bed load sediment transport with

limited erosion bed areas

In the Sediment Transport model you can define areas with a maximum erosion depth. This is useful
to represent pavements, rock outcrops or any surface that does not erode or that it has a known
erodible layer of sediment above it. This tutorial illustrates how to perform a sediment transport
simulation in which there is a non-erodible area using the QGIS interface. The procedure includes
the following steps:

1. Open an existing RiverFlow2D project.

2. Create a ‘MaximumErosionDepth’ layer and the polygons that define the limited erosion areas.

3. Generate the mesh.

4. Running the model.

The files required to follow this tutorial can be extracted from the ‘ExampleProjects’ zip file under the
‘MaxErosionDepth’ folder. This zip file is downloaded separately from your installation materials.

9.1 Open an existing project
1. Open QGIS

2. In the main menu go to Project → Open… browse to the existing tutorial folder: .

This project contains the layers of the domain outline, of the digital elevation model DEM of the river
bed in raster format, the layer with the boundary conditions where inflow is located in the upper left
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and outflow in the lower left. The boundary conditions are a hydrograph with a peak discharge of
6,500 ft3/s and outflow condition is set to free outflow. The MeshDensityLine layer is there to refine
the mesh in the mesh generation step. When you open the project you will have a project image
loaded in QGIS as shown in Figure 9.1.

Figure 9.1 – Project screen loaded in QGIS.

9.2 Add MaximumErosionDepth layer and draw the
polygon that defines the area of limited erosion

Defining the limited erosion areas involves the following steps:

1. Create the template for the MaximumErosionDepth layer: In the RiverFlow2D toolbar click on
the New Template Layer button

2. Activate the checkbox MaximumErosionDepth, as shown in the Figure below:
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Plugin to add a New Template Layer.

3. Edit the MaximumErosionDepth layer: In the layers panel, select the MaximumErosionDepth
layer and in the digitalization toolbar click on the Toggle editing button

A pencil icon will appear in the MaximumErosionDepth layer, indicating that the layer is in edit
mode:

4. Draw the polygon of the limited erosion area: Using the Add Feature tool:

Draw the polygon that defines the area of limited erosion. The polygon should cover all the
cells that will have limiting erosion. In this tutorial we will assume that an area on the river has
the maximum erosion depth limited to 0.1 feet, at the end you should have an image similar
to the one shown in the following figure:
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Polygon of the area with limited erosion.

Once you finish drawing the polygon, the window to input the area parameters immediately
appears. Input a maximum depth of erosion of 0.1 feet, as shown below:

Window for input the polygon parameters of MaximumErosionDepth layer.

5. Click on the OK button to save the parameters.

6. Save the changes to the layer by clicking on the Save button of the digitalization toolbar.

7. Exit the editing mode by clicking on the Toggle editing button of the digitalization toolbar.
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9.3 Generate the mesh

Generate the mesh using the Generate TriMesh button

The results obtained as shown in Figure 9.5 (mesh of close to 15,000 cells).

Figure 9.2 – The mesh generated.
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9.4 Exporting files to RiverFlow2D

Now that you have generated the mesh and you have the other layers with the necessary data,
export the files in the format required by RiverFlow2D.

1. Click on the Export RiverFlow2D button

2. When run the plugin a window is displayed, select the raster layer that contains the Digital
Elevation Model (DEM) and the name of the project to be exported. Input the name without
any extension. For this example it will be: ‘MaxErosion’.

3. Before running the plugin activate the layer with the DEM (if it is deactivated).

Once the plugin is executed, a window will be shown (Figure 9.6), as it should be for our
example.

Plugin window to export the files to RiverFlow2D.

4. Once finished inputting the information, click on the OK button and the export process will
begin.

Once it is finished, RiverFlow2D will be loaded with the ‘MaxErosion.DAT’ file of the specific example.

9.5 Running the model

After exporting the files, RiverFlow2D is loaded with the project file of the ‘MaxErosion.DAT’ example
and shows the Control Data panel to it as illustrated in Figure 9.7
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Figure 9.3 – Control data panel.

Note that the sediment transport module appears selected and displays a message warning that the
file with the sediment information must be created. The procedure includes the following steps:

1. To create the ‘.SEDB’ file with the parameters to calculate sediment transport: in the Modules
list select Sediment Transport.

2. Enter the parameters for transport in suspension and bed load transport, for this example the
Sediment Transport Mode checkbox for Suspended Sediments is deactivated and Bed Load
Sediment is left active.

3. Add the sediment fractions to be considered: for this example add a single fraction with the
default values presented by the Hydronia Data Input Program, we will have an image similar
to the one shown in the following Figure:

RiverFlow2D Sediment Transport Module.

Leave all other parameters at their default values.
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4. Click the [Save SED* Files] button and leave the default name provided, click [Save].

5. To run the model, click on the Run RiverFlow2D button in the lower section of Hydronia Data
Input Program.

6. Click [Yes] when asked to save changes. By default it will prompt to overwrite the existing
‘base.DAT’, click [OK].

The window presented while running the model shows: simulation time, volume conservation error,
total discharge of the liquid flow in and out and in this case also shows the sediment load at the inlet
and outlet as well as other parameters as the execution progresses (Figure 10.6).

Figure 9.4 – RiverFlow2D output graphics.

9.6 Check the output files
RiverFlow2D creates the following files for output time interval defined in the Control Data panel:
‘CELL_TIME_METRIC_DDDD_HH_MM_SS.TEXTOUT’ (Metric Units) or
‘CELL_TIME_ENG_DDDD_HH_MM_SS.TEXTOUT’ (English Units)
where DDDD indicates the date, HH, hour, MM minutes and SS seconds.
Column 6 reports the changes in the elevation of the river bed with respect to the initial elevation. We
can also visualize the changes in the elevation of the riverbed generating layers in vectorial format
map from the aforementioned files using the Maps of Results vs Time plugin in QGIS, specifically
the Delta Bed Elevations map:
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In the following figure, the river elevation difference map for the end of the run. At the time 0000:02:00:00
it can be observed that the zone where the erosion was limited, does not present erosion, but de-
position:

Figure 9.5 – Maps of elevation difference of the river bed between the initial time and at the end of the
run.

This concludes the Simulating bed load sediment transport tutorial.



10
Simulating suspended sediment transport with
inflows of suspended sediment concentrations

In the Sediment Transport model you can define inflows of suspended sediment concentrations.
This is useful to represent the spatial distribution of said sediments in the modeling domain. This
exercise illustrates how to configure and perform a suspended sediment transport simulation using
RiverFlow2D in which there is an inflow of suspended sediment concentrations using the QGIS
interface. The procedure includes the following steps:

1. Open an existing RiverFlow2D project.

2. Export the project to Hydronia Data Input Program.

3. Edit the parameters in the Hydronia Data Input Program.

4. Running the model.

The files required to follow this tutorial can be extracted from the ‘ExampleProjects’ zip file under the
‘SuspendedSediments’ folder. This zip file is downloaded separately from your installation materials.

10.1 Open an existing project
1. Open QGIS

2. In the main menu go to Project → Open… browse to the existing exercise folder: .

This project comes with preconfigured layers: a domain outline with cells of 100m size, a the digital
elevation model DEM of the river bed in raster format, the layer with the boundary conditions where
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inflow is located in the upper right and outflow in the lower left. The boundary conditions are a
hydrograph with a peak discharge of 220000 ft3/s and outflow condition is set to Uniform Flow
Condition. When you open the project you will have a project image loaded in QGIS as shown in
Figure 10.1.

Figure 10.1 – Project screen loaded in QGIS.

10.2 Exporting files to RiverFlow2D

The project is already set up within QGIS, so we can export the files to RiverFlow2D.

1. Click on the Export RiverFlow2D button

2. When run the plugin a window is displayed, select the raster layer that contains the Digital
Elevation Model (DEM) and the name of the project to be exported.

3. Before running the plugin activate the layer with the DEM (if it is deactivated).
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Plugin window to export the files to RiverFlow2D.

4. After entering all the required information, click [OK] to begin the export process.

Once the export process completes, RiverFlow2D will automatically load the project’s ‘base.DAT’
file.

10.3 Running the model
After exporting the files, RiverFlow2D loads the project file ‘base.DAT’ and displays the Control Data
panel as shown in Figure 10.3

Figure 10.2 – Control data panel.

Note that the sediment transport module is not selected by default. The Hydronia Data Input Pro-
gram should be configured as follows:

1. On the Control Data panel, click on Sediment Transport module. (If you have an Nvidia GPU,
you can click on RiverFlow2D GPU under Model Selection.)



10.3 Running the model 78

2. To create the ‘.SEDB’ file with the parameters to calculate sediment transport: in the Modules
list select Sediment Transport.

3. Enter the parameters: In this example the Sediment Transport Mode checkbox for Bed Load
Sediment is deactivated and Suspended Sediments is left active.

4. In the Suspended Sediment Transport section: Uncheck the option for Bed Fraction Evolution.

5. Under the Dispersion coefficient section, give the values 0.1 for Longitudinal and 0.001 for
Transversal.

6. Click on Add Suspended Sediment Fraction to add a single fraction with the default values
presented by the Hydronia Data Input Program, we will have an image similar to the one
shown in the following Figure:

RiverFlow2D Sediment Transport Module.

Leave all other parameters at their default values.

7. Click the [Save SED* Files] button and leave the default name provided, click [Save].

8. On the left-hand panel, click on Open Boundary Conditions.

9. In the Boundary Conditions panel, click on the entry for BC 1, Discharge vs. Time. A message
should be displayed indicating that you will need to add a column for each concentration that
is configured in the Sediment Transport module:

Message indicating that you will need to add a column for each concentration that is configured
in the Sediment Transport module.



7910. Simulating suspended sediment transport with inflows of suspended sediment concentrations

10. In the section displaying the contents of the ‘Inflow_1.QVT’ file, scroll to the right and add the
concentrations 0.01 to each row in the Conc.1 column.

11. Once entered, a warning message should be displayed indicating that the ‘Inflow_1.QVT’ file
has been modified, click [Yes] to save the changes.

12. To run the model, click on the Run RiverFlow2D button in the lower section of Hydronia Data
Input Program.

13. Click [Yes] when asked to save changes. By default it will prompt to overwrite the existing
‘base.DAT’, click [OK].

The window presented while running the model shows: simulation time, volume conservation error,
total discharge of the liquid flow in and out and in this case also shows the sediment load at the inlet
and outlet as well as other parameters as the execution progresses (Figure 10.6).

Figure 10.3 – RiverFlow2D output graphics.

10.4 Check the output files
RiverFlow2D creates the following files for output time interval defined in the Control Data panel:
‘cell_st_DDDD_HH_MM_SS.textout’
Where DDDD indicates the date, HH, hour, MM minutes and SS seconds.
The format for these files is as follows: The first line indicates the number of suspended sediment
classes/fractions used in the ST run times 2 plus 1 (2*NSSNFRAC+1). Then follows NELEM lines
with results for each cell in the triangular-cell mesh.
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10.5 Generate a Concentration Map
1. Click the Results vs Time Maps button.

2. Select Concentrations and Properties versus Time Maps.

3. In the Maps section, select Concentration_1.

4. In the Output Times section, select the desired time (e.g., 0000:02:00:00).

5. Move the second desired output time to the Output Map section by clicking the right arrow
button (→).

6. Click OK to generate the map.

Figure 10.4 – Map of suspended sediment concentration for the last time step.

This concludes the Simulating suspended sediment transport with inflows of suspended sediment
concentrations exercise.
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Hydrologic simulations

The conceptual model of a hydrologic simulation with RiverFlow2D requires a series of non-overlapping
polygons where the rainfall/evaporation and infiltration data will be assigned to the mesh. Only ar-
eas covered by polygons will receive rainfall or consider infiltration depending on the case. Each
Rainfall/Evaporation polygon should be associated with a file containing a rainfall and evaporation
time-series file. Similarly, each Infiltration polygon should correspond with a file containing the in-
filtration calculation method and its parameters for the polygon. The user will need to generate the
rainfall and infiltration data files associated with each polygon, and copy them to the project folder
prior to running the model.
This tutorial illustrates how to perform a hydrologic simulation accounting for rainfall, evaporation
and infiltration. The procedure includes the following steps:

1. Create the rainfall and evaporation time series data files.

2. Create the infiltration data files.

3. Open an existing RiverFlow2D project.

4. Add the template of the RainEvap component layer and the rain/evaporation polygons.

5. Add the template of the Infiltration component layer and the Infiltration polygons.

6. Generate the mesh.

7. Running the model.

8. Visualize model results.

The files required to follow this tutorial can be extracted from the ‘ExampleProjects’ zip file under
the ‘RainfallInfiltrationTutorial’ folder. This zip file is downloaded separately from your installation
materials.
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11.1 Create the rainfall and evaporation time series data
file

To run a hydrologic simulation with RiverFlow2D, polygons will be created on which the rainfall/
evaporation data will be applied. The first step is to create the ASCII text files with the rainfall and
evaporation time series that will be associated with each polygon. These files can be created with
any text editor, such as Notepad or Wordpad. The rainfall/evaporation file has the following format:
Line 1: NPRE Number of points in the time series of rainfall and evaporation
Then follows NPRE lines containing:
Time (hr) Precipitation intensity (mm/h or in/h) Evaporation (mm/h or in/h)
The following table is an excerpt of the ‘Rainfall1.dat’ file that is included in the folder for this tutorial.
In this example, evaporation is assumed to be zero at all times. Figure 11.1 shows the graphical
representation of the rainfall time series in the ‘Rainfall1.dat’ file.
18
0.0 0.0 0.0
0.08 1.8 0.0
0.17 3.5 0.0
0.25 7.8 0.0
0.33 12.0 0.0
0.42 15.0 0.0
...
1.17 9.0 0.0
1.25 4.7 0.0
1.33 3.0 0.0
1.42 2.4 0.0

Figure 11.1 – Rain intensity time series.
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11.2 Create the infiltration parameters data file

To take into account infiltration, polygons will be created in which you specify the infiltration calcula-
tion method and its corresponding data. The infiltration polygons are completely independent from
the precipitation polygons. Each polygon can use a different method with its associated parameters.
You will need to create the infiltration ASCII text file for each polygon. These files can be created
with any text editor, such as Notepad or Wordpad. The infiltration file is described in detail in the
RiverFlow2D Reference Manual. For this tutorial, given that the watershed has an area with natural
coverage in the upper area and another with urban use in the lower area of watershed, we will use
two infiltration files using the the SCS-CN method to calculate the infiltration. File ‘Infiltration1.dat’
will be used for the upper watershed, and for the lower urban zone, ‘Infiltration2.dat’ file. Both files
are provided in the folder for this tutorial.

11.3 Open an existing project

1. Open QGIS

2. On the Project menu click Open… and browse to the existing project: ‘RainfallInfiltrationTuto-
rial.qgz’. This project contains the information to simulate the rainfall runoff resulting from a
10 yr storm. The layers contained are the following:

• Domain Outline

• Digital Elevation Model (DEM) in raster format

• Aerial photography

• Polygons with the Manning’s n coefficients

• Cross section at watershed outlet

• Outflow boundary conditions set to free outflow

When you open the project you will have an view similar as that shown in Figure 6-2.
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Rainfall and infiltration tutorial loaded in QGIS.

11.4 Add the RainEvap component layer, and the
rainfall/evaporation polygons

To add the RainEvap where the polygons are drawn with the rainfall and evaporation data, do the
following:

1. To create RainEvap layer use the New Template Layer button

2. In the window check RainEvap, as shown in the Figure below. Then click OK:
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Add Layer Template dialog with RainEvap selected.

3. Edit the RainEvap layer: In the layers panel, select the RainEvap layer and click on the Toggle
Editing button in the digitization bar

A pencil icon will appear in the RainEvap layer, indicating that the layer is in edit mode:

4. Draw the polygon that demarcates the spatial distribution of rainfall and evaporation: Using
the Add Feature tool from the digitalization bar

draw the rainfall/evaporation polygon, as only one file will be used. The polygon should covers
the entire Domain Outline as shown in the figure below:
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Polygon with the spatial distribution of Rainfall/evaporation data.

5. Right-click to close the polygon. A dialog box will appear to enter the RainEvap Feature At-
tributes.

6. Input the parameters or attributes of the RainEvap polygon: Click on the browse […]button
and select the ‘Rainfall1.dat’ file in the scenario folder.

7. Save the changes in the RainEvap layer and click the pencil icon to disable editing mode.

11.5 Add the Infiltration component layer, and the
Infiltration polygons

To add the infiltration information, do as follows:

1. To create the Infiltration layer y use the New Template Layer button

2. In the dialog select Infiltration, as shown in the Figure below:



87 11. Hydrologic simulations

Add Layer Template dialog with Infiltration selected.

3. Edit the Infiltration layer: In the layers panel, select the Infiltration layer and click on the Toggle
Editing button.

A pencil will appear in the Infiltration layer, indicating that the layer is in edit mode:

4. Draw the polygon that demarcates the spatial distribution of the infiltration: Using the tool Add
Feature tool of the digitalization bar, draw the infiltration polygons

Figure 11.6 shows the polygons that define the two infiltration zones of the watershed that are
based on the land use and vegetation cover.
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Infiltration areas of the watershed.

5. Draw a polygon for the infiltration2 area trying to maintain the shape as indicated in the previous
figure and that protrudes from the polygon of the Domaine Outline as shown in the figure below:

Polygon of the infiltration2 area of the watershed.

6. Once completing the polygon, the dialog to input the parameters opens. Browse to the input
file Infiltration2.txt, as shown below:



89 11. Hydrologic simulations

Window to input the parameters for the infiltration2 polygon.

7. To draw the second polygon corresponding to infiltration2 use the snapping option as shown
in the section Advanced Digitalization/Snapping Tutorial and there should be a polygon like
the one shown in the following figure:

Polygons of the infiltration areas of the watershed.

8. Once finished drawing the polygon, enter the file name ‘Infiltration1.txt’ as shown:



11.6 Generate the mesh 90

Dialog to enter the parameters for the infiltration1 polygon.

11.6 Generate the mesh
The mesh is generated using the Generate TriMesh icon

Figure 11.11 shows the resulting mesh of about 70,000 cells.

Figure 11.2 – Final mesh.
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11.7 Exporting files to RiverFlow2D

Now that once you have generated the mesh and the other layers are ready with the necessary
data, you should export the files in the format required by RiverFlow2D. We will use the Export
RiverFlow2D icon.

1. Click on the Export RiverFlow2D icon.

When running the export command, you need to select the raster layer that contains the Digital
Elevation Model (DEM). The name of the current scenario will already be indicated in the
dialog.

Export dialog.

2. Click on the [OK] button and the export process will begin. Once finished, the RiverFlow2D
program will be loaded with the ‘base.DAT’ file.

11.8 Running the model

After exporting the files, the Hydronia Data Input Program is loaded with the project file from the
‘base.DAT’ example and shows the Control Data panel as illustrated in Figure 11.13
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Figure 11.3 – Control data panel.

As shown above, the Rainfall Components Evaporation/Infiltration are selected in the data panel.

1. Under Time control data set the Output interval for components (hrs) to 0.1.

If you have an nVidia GPU installed, you may select the RiverFlow2D GPU radial button under
Model Selection to accelerate the model execution

2. Click [Save .DAT] to overwrite the existing ‘base.dat’ file.

3. Select Rainfall/Evaporation of the Conponents section in left-hand panel.

The rainfall data contained in the ‘rainfall1.txt’ file will appear (Figure 11.14). In the Infiltration
panel the data contained in the Infiltration1 and Infiltration2 files is shown (Figure 11.15).

Rainfall/Evaporation component data panel.
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Infiltration component data panel.

4. Leave all other parameters at their default values.

5. To run the model, click on the Run RiverFlow2D button. A window will appear indicating that
the model began to run. The window also report the simulation time, volume conservation
error, total input and output discharge, and other parameters as the execution progresses
(Figure 11.16).

RiverFlow2D output graphics.
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11.9 Utilizing the Cross Section Tool to review output
files

1. In QGIS, click on the Cross Section icon.

2. The Cross Sections panel will appear on the bottom of the QGIS interface.

The outflow hydrograph can be visualized using the cross section tool as shown in Figure
11.17:

Output hydrograph of output.

This concludes the Hydrologic simulations tutorial.
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Urban Drainage using RiverFlow2D and

EPA-SWMM

This tutorial illustrates how to apply the RiverFlow2D Urban Drainage module that integrates sur-
face flooding with EPA-SWMM storm drain model. The project objective is to assess the shallow
inundation originating from a surcharging underground pipe. The procedure involves the following
steps:

1. Create a SWMM application.

2. Open an existing RiverFlow2D model.

3. Import the surface-storm drain exchange points from the’.INP’ SWMM file.

4. Generate the mesh.

5. Export the files of RiverFlow2D.

6. Run the model.

The files required to follow this tutorial can be extracted from the ‘ExampleProjects’ zip file under
the ‘UrbanDrainageTutorial’ folder. This zip file is downloaded separately from your installation ma-
terials.
The pipe is modeled in 1D and connected to the 2D mesh through a manhole. The modeled area
is approximately 0.4 km by 0.96 km (see Figure 12.1). A storm drain of circular section of 1.4m in
diameter and 1340 m in length is assumed to run through the modeled area. The pipe Manning’s
roughness is set to n=0.017. An inflow boundary condition is applied at the upstream end of the pipe,
illustrated in Figure 12.2. A free outfall is considered as downstream boundary condition. A base
initial flow of 1.6 m3/s is set as uniform initial condition. A surcharge is expected to occur at a vertical
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manhole of 1 m2 cross-section located 467 m from the top end of the culvert at the coordinates
(x=264,896 m,y=664,747 m). The profile geometry of the culvert is given in Table [pipe012] and
shown in Figure 12.3.

Figure 12.1 – DEM used, with the location of the manhole. The course of the storm drain is indicated,
although irrelevant to the modeling. Purple lines: outline of roads and pavements. Black lines: building
outlines. Triangles: output point locations.

Figure 12.2 – Inflow hydrograph applied at upstream end of storm drain.

c c c c c Node

Distance from
upstream
inlet (m)

Invert level
(m)

Reach length
(m) X Y

N1 0� 39.17 - 264896.000 664747.000
N2_manhole 467� 29.46 467 264896.000 664747.000
N3 571� 27.70 104 265633.232 664154.002
N4 677� 26.37 106 266474.164 663829.787
N5 877� 25.70 200 267730.496 663302.938
N6 991� 24.64 114 268470.111 662978.723
N7 1145� 24.29 154 269533.941 662725.431
Out1 1340� 23.49 195 271874.367 661752.786
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Figure 12.3 – Storm drain profile.

12.1 Storm drain configuration in EPA-SWMM
If you want to skip this step, you may want to use the SWMM ‘base.INP’ in the tutorial folder. In that
case, please go to section 12.1.1.

1. Open the SWMM application.

2. The first step consists in setting the position of all the nodes that conforms the drainage network
by means of the button Add a junction node:

On the Study area map window, click as many times as nodes should be added to the network.
In this project there will be 8 nodes. Note that the position of the nodes is schematic:
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3. Configure the node data by double-clicking on each node. The node properties window should
appear:

image image

In this example, the most relevant parameters are: Name, X- and Y-Coordinates, Inflows, Invert
elevation and Max. depth. The only inflow nodes are N1 and N2_manhole. Node N2_manhole
should have Max. depth=2 m. Node N1 is the discharge input and should follow the time series
given in Figure 12.2.

The time series can be inserted point-by-point or read from file. On the other hand, node
N2_manhole will be the connection with the surface domain and the baseline values should
be 0.0:

image image

The outfall node Out1 should be configured as free:
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4. Join the nodes by means of the Add a conduit link tool:

The result should look like the following figure:
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5. Configure the link properties by double-clicking on each one:

The most relevant properties are: Name, Inlet node, Outlet node, Shape, Max. depth, Length,
Roughness and Initial flow.

6. Once the network is completely configured, the project should be saved in order to generate
the ‘.INP’ file that should be similar to the one shown below.

[EVAPORATION]
; ; Data Source Parameters
;;−−−−−−−−−−−−−− −−−−−−−−−−−−−−−−
CONSTANT 0.0
DRY_ONLY NO

[JUNCTIONS]
; ; Name Eleva t ion MaxDepth I n i t D e p t h SurDepth Aponded
;;−−−−−−−−−−−−−− −−−−−−−−−− −−−−−−−−−− −−−−−−−−−− −−−−−−−−−− −−−−−−−−−−
N1 39.17 0 0 0 0
N2_manhole 29.46 2 0 0 0
N3 27.7 0 0 0 0
N4 26.37 0 0 0 0
N5 25.7 0 0 0 0
N6 24.64 0 0 0 0
N7 24.29 0 0 0 0

[OUTFALLS]
; ; Name Eleva t ion Type Stage Data Gated Route To
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;;−−−−−−−−−−−−−− −−−−−−−−−− −−−−−−−−−− −−−−−−−−−−−−−−−− −−−−−−−− −−−−−−−−−−−−−−−−
Out1 23.49 FREE NO

[CONDUITS]
; ; Name From Node To Node Length Roughness
I n O f f s e t OutOf fset I n i t F l o w MaxFlow
;;−−−−−−−−−−−−−− −−−−−−−−−−−−−−−− −−−−−−−−−−−−−−−− −−−−−−−−−− −−−−−−−−−− −−−−−−−−−− −−−−−−−−−− −−−−−−−−−− −−−−−−−−−−
L1 N1 N2_manhole 467 0.017
0 0 1.6 0
L2 N2_manhole N3 104 0.017
0 0 1.6 0
L3 N3 N4 106 0.017
0 0 1.6 0
L4 N4 N5 200 0.017
0 0 1.6 0
L5 N5 N6 114 0.017
0 0 1.6 0
L6 N6 N7 154 0.017
0 0 1.6 0
L7 N7 Out1 195 0.017
0 0 1.6 0

[XSECTIONS]
; ; L ink Shape Geom1 Geom2 Geom3 Geom4
Bar re l s Cu lve r t
;;−−−−−−−−−−−−−− −−−−−−−−−−−− −−−−−−−−−−−−−−−− −−−−−−−−−− −−−−−−−−−− −−−−−−−−−− −−−−−−−−−− −−−−−−−−−−
L1 CIRCULAR 1.4 0 0 0
1
L2 CIRCULAR 1.4 0 0 0
1
L3 CIRCULAR 1.4 0 0 0
1
L4 CIRCULAR 1.4 0 0 0
1
L5 CIRCULAR 1.4 0 0 0
1
L6 CIRCULAR 1.4 0 0 0
1
L7 CIRCULAR 1.4 0 0 0
1

[ INFLOWS]
; ; Node Cons t i t uen t Time Ser ies Type Mfactor S fac to r
Basel ine Pat te rn
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;;−−−−−−−−−−−−−− −−−−−−−−−−−−−−−− −−−−−−−−−−−−−−−− −−−−−−−− −−−−−−−− −−−−−−−− −−−−−−−− −−−−−−−−
N1 FLOW discharge_ in f low FLOW 1.0 1
N2_manhole FLOW ” ” FLOW 1.0 1.0
0.0

[ TIMESERIES ]
; ; Name Date Time Value
;;−−−−−−−−−−−−−− −−−−−−−−−− −−−−−−−−−− −−−−−−−−−−
d ischarge_ in f low 0:00 1.6
d ischarge_ in f low 0:02 1.6
d ischarge_ in f low 0:04 1.6
d ischarge_ in f low 0:06 1.6
d ischarge_ in f low 0:08 1.61644
d ischarge_ in f low 0:10 1.6336
d ischarge_ in f low 0:12 1.65472
d ischarge_ in f low 0:14 1.67188
d ischarge_ in f low 0:16 1.68904
d ischarge_ in f low 0:18 1.70488
d ischarge_ in f low 0:20 1.71808
d ischarge_ in f low 0:22 1.71808
d ischarge_ in f low 0:24 1.7392
d ischarge_ in f low 0:26 1.75636
d ischarge_ in f low 0:28 1.77352
d ischarge_ in f low 0:30 1.7986
d ischarge_ in f low 0:32 1.82764
d ischarge_ in f low 0:34 1.8448
d ischarge_ in f low 0:36 1.88704
d ischarge_ in f low 0:38 1.92136
d ischarge_ in f low 0:40 1.95436
d ischarge_ in f low 0:42 1.98868
d ischarge_ in f low 0:44 2.02168
d ischarge_ in f low 0:46 2.056
d ischarge_ in f low 0:48 2.09824
d ischarge_ in f low 0:50 2.1484
d ischarge_ in f low 0:52 2.19988
d ischarge_ in f low 0:54 2.25928
d ischarge_ in f low 0:56 2.32264
d ischarge_ in f low 0:58 2.3728
d ischarge_ in f low 1:00 2.4784
d ischarge_ in f low 1:02 2.56288
d ischarge_ in f low 1:04 2.66056
d ischarge_ in f low 1:06 2.77012
d ischarge_ in f low 1:08 2.8876
d ischarge_ in f low 1:10 3.0064
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discharge_ in f low 1:12 3.17536
d ischarge_ in f low 1:14 3.29416
d ischarge_ in f low 1:16 3.44992
d ischarge_ in f low 1:18 3.61888
d ischarge_ in f low 1:20 3.78784
d ischarge_ in f low 1:22 3.9568
d ischarge_ in f low 1:24 4.168
d ischarge_ in f low 1:26 4.33696
d ischarge_ in f low 1:28 4.50592
d ischarge_ in f low 1:30 4.67488
d ischarge_ in f low 1:32 4.83988
d ischarge_ in f low 1:34 4.99168
d ischarge_ in f low 1:36 5.16064
d ischarge_ in f low 1:38 5.27944
d ischarge_ in f low 1:40 5.41012
d ischarge_ in f low 1:42 5.54476
d ischarge_ in f low 1:44 5.67148
d ischarge_ in f low 1:46 5.77312
d ischarge_ in f low 1:48 5.89984
d ischarge_ in f low 1:50 6.00148
d ischarge_ in f low 1:52 6.10312
d ischarge_ in f low 1:54 6.1876
d ischarge_ in f low 1:56 6.24096
d ischarge_ in f low 1:58 6.28111
d ischarge_ in f low 2:00 6.28111
d ischarge_ in f low 2:02 6.24096
d ischarge_ in f low 2:04 6.1876
d ischarge_ in f low 2:06 6.10312
d ischarge_ in f low 2:08 6.00148
d ischarge_ in f low 2:10 5.89984
d ischarge_ in f low 2:12 5.77312
d ischarge_ in f low 2:14 5.67148
d ischarge_ in f low 2:16 5.54476
d ischarge_ in f low 2:18 5.41012
d ischarge_ in f low 2:20 5.27944
d ischarge_ in f low 2:22 5.16064
d ischarge_ in f low 2:24 4.99168
d ischarge_ in f low 2:26 4.83988
d ischarge_ in f low 2:28 4.67488
d ischarge_ in f low 2:30 4.50592
d ischarge_ in f low 2:32 4.33696
d ischarge_ in f low 2:34 4.168
d ischarge_ in f low 2:36 3.9568
d ischarge_ in f low 2:38 3.78784
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d ischarge_ in f low 2:40 3.61888
d ischarge_ in f low 2:42 3.44992
d ischarge_ in f low 2:44 3.29416
d ischarge_ in f low 2:46 3.17536
d ischarge_ in f low 2:48 3.0064
d ischarge_ in f low 2:50 2.8876
d ischarge_ in f low 2:52 2.77012
d ischarge_ in f low 2:54 2.66056
d ischarge_ in f low 2:56 2.56288
d ischarge_ in f low 2:58 2.4784
d ischarge_ in f low 3:00 2.3728
d ischarge_ in f low 3:02 2.32264
d ischarge_ in f low 3:04 2.25928
d ischarge_ in f low 3:06 2.19988
d ischarge_ in f low 3:08 2.1484
d ischarge_ in f low 3:10 2.09824
d ischarge_ in f low 3:12 2.056
d ischarge_ in f low 3:14 2.02168
d ischarge_ in f low 3:16 1.98868
d ischarge_ in f low 3:18 1.95436
d ischarge_ in f low 3:20 1.92136
d ischarge_ in f low 3:22 1.88704
d ischarge_ in f low 3:24 1.8448
d ischarge_ in f low 3:26 1.82764
d ischarge_ in f low 3:28 1.7986
d ischarge_ in f low 3:30 1.77352
d ischarge_ in f low 3:32 1.75636
d ischarge_ in f low 3:34 1.7392
d ischarge_ in f low 3:36 1.71808
d ischarge_ in f low 3:38 1.71808
d ischarge_ in f low 3:40 1.70488
d ischarge_ in f low 3:42 1.68904
d ischarge_ in f low 3:44 1.67188
d ischarge_ in f low 3:46 1.65472
d ischarge_ in f low 3:48 1.6336
d ischarge_ in f low 3:50 1.61644
d ischarge_ in f low 3:52 1.6
d ischarge_ in f low 3:54 1.6
d ischarge_ in f low 3:56 1.6
d ischarge_ in f low 3:58 1.6
d ischarge_ in f low 5:00 1.6

[REPORT]
; ; Report ing Options
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INPUT NO
CONTROLS NO
SUBCATCHMENTS ALL
NODES ALL
LINKS ALL

[TAGS]

[MAP]
DIMENSIONS 260000.000 660000.000 270000.000 670000.000
Uni ts Meters

[COORDINATES]
; ; Node X−Coord Y−Coord
;;−−−−−−−−−−−−−− −−−−−−−−−−−−−−−−−− −−−−−−−−−−−−−−−−−−
N1 264903.824 664753.843
N2_manhole 264896.000 664747.000
N3 265633.232 664154.002
N4 266474.164 663829.787
N5 267730.496 663302.938
N6 268470.111 662978.723
N7 269533.941 662725.431
Out1 271874.367 661752.786

[VERTICES]
; ; L ink X−Coord Y−Coord
;;−−−−−−−−−−−−−− −−−−−−−−−−−−−−−−−− −−−−−−−−−−−−−−−−−−

12.1.1 Starting QGIS

Start the QGIS software. After loading we will have a window similar to the one shown below:



12.1 Storm drain configuration in EPA-SWMM 106

Figure 12.4 – QGIS interface.

12.1.2 Start a new RiverFlow2D project
1. In the RiverFlow2D toolbar, click on the New RiverFlow2D Project button

to start a new RiverFlow2D project. A dialog window appears where you select the layers that
will be created, the Coordinate Reference System (CRS), and the directory path where the
layers will be saved. This example will use the basic layers: Domain Outline, Manning N, and
BoundaryConditions

2. Select None in the Layers dropdown menu.

3. Select the Projection button.

4. In the Filter textbox, type 7405 and select the Coordinate Reference System as shown:
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Coordinate Reference System Selector dialog window.

5. Click OK.

6. The Coordinate Reference System (CRS) EPSG code: 7405 should be selected, and the
dialog window will look like this:

Create New RiverFlow2D Project.

7. Click the “…” button to provide a path to store the project files in the Project Directory textbox.
For this example you may browse to the UrbanDrainageTutorial folder.

8. After clicking OK, the layer templates are created, and displayed on the Layers Panel:

Layers created for the project.

RiverFlow2D will use the unit system as that defined in the projection you selected. If the
projection has coordinates in meters, units will be set to Metric. If the projection coordinates
are in feet, units will be set to English.

9. On the QGIS Project menu, click Save, to save the project in the same directory that you
previously selected in the Create New Project dialog above.
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12.1.3 Load elevation data
RiverFlow2D uses elevation data in raster format. To load an ASCII grid file, from the Layer menu,
click Add Layer, and then click Add Raster Layer… You may also click the Add Raster Layer button:

Search for the ‘TEST8BDEM.ASC’ in the ‘UrbanDrainageTutorial\base’ folder:

1. Click Add, assign the EPSG:7405 projection code to the file, and raster will be displayed on
the screen, by default it is rendered in gray gradient as shown in Figure 19.7.

Digital elevation model in raster format.

Right-clicking on the label of the created layer and selecting Properties allows you to change
the rendering style for a more informative color palette.
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Window to change the raster layer render style.

And now the raster layer is displayed with the new color palette selected:

Digital elevation model with color render.

It is convenient to move the raster layer created to the end of the list of layers, thus it does not
interfere with the display of other layers.

12.1.4 Import the surface-storm drain exchange node
connections from the SWMM .INP file

To connect the surface water mesh with the storm drain components, we will import the ex-
change nodes from the ‘.INP’ file created in the first part of this tutorial. For that we will use
the Import EPA-SWMM INP file command from the RiverFlow2D tools drop down icon:
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Import EPA-SWMM INP file command

Select the ‘base.INP’ file and a message will indicate the transfer was successful:

.INP successfully loaded

You will note that there is a new StormDrain layer created and the imported exchange nodes
are displayed:

Surface water-SWMM exchange nodes.

12.1.5 Create the limits of the modeling area
The limits of the modeling area are defined using a polygon on the Domain Outline layer. To create
it do as follows:

1. Click the Domain Outline layer to activate it and then click Toggle Editing (pencil) in the toolbar:

Menu buttons for digitalization toolbar.

2. This activates the rest of the editing buttons. Now click the Add Feature tool which is the bean
looking polygon.

Proceed to delineate the outline of the polygon by marking the vertices clicking with the left
mouse button:
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Modeling area delimitation on the Domain Outline layer.

Make sure that the polygon is contained within the limits of the raster layer since RiverFlow2D
will not extrapolate elevations to areas that are outside of the available data on the raster layer.
Also, the SWMM exchange nodes should be inside the Domain Outline polygon.

3. To finalize and close the polygon, right-click anywhere on the map view area. A dialog window
to input the cell size attribute of the newly created polygon. The value for the reference size
of the mesh cell is indicated. Enter a value of 10 m.

CellSize defined for the Domain Outline layer.

Now click on Toggle Editing button to deactivate the layer Edit mode and save the changes.

The Domain Outline is now complete.
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Figure 12.5 – Domain Outline layer.

12.1.6 Assigning Manning’s n
To assign Manning’s n roughness values, we will enter polygons with given n’s. There can be
as many polygons as those required to reproduce the spatial variability of this parameter. In this
example, a single polygon will be drawn for the entire area.

1. Select the Manning N layer and click the Toggle Editing button:

2. Draw the polygon around the entire domain taking care that it covers all the cells.

You should have an image like the one shown below:

Editing the Manning N layer.
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3. Close the last vertices on the polygon by right-clicking on the desired position. The following
dialog window is presented where you must input the Manning’s n value associated to the
polygon. For this case, enter 0.03:

Dialog to input Manning N Feature Attributes.

4. Click the Save button

and then click the Editing Tool button

to deactivate editing mode.

12.1.7 Imposing the boundary conditions
By default all boundaries are closed unless we set open boundary conditions. Since in this project
flow is input from the storm drain, we will set only outflow conditions. To define the boundary condi-
tions draw a polygon that includes the nodes or vertices at the left end of the mesh as indicated in
the figure:

Figure 12.6 – Polygon that covers the nodes defining the Outflow boundary condition segment.
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1. Select the BoundaryConditions layer in the Layers panel.

2. Click the Toggle Editing button to add the polygons that are going to indicate the nodes on
which the inflow and outflow conditions are established.

3. To finish the polygon, right-click on desired location. A window to enter the attributes of the
newly created polygon is displayed.

4. The window contains a list to select the name of ID of this BC (Boundary Cond. ID), set Id to
OUTFLOW condition, and from the list of boundary condition Types select Free Outflow.

Enter the data as shown in Figure 12.21 below:

Outflow Boundary Condition.

5. Click the Save button:

6. Click the Toggle Editing button to exit editing mode.

12.1.8 Generating the triangular-cell mesh

Now that the Domain Outline has been set, the Manning’s n entered, and the SWMM nodes have
been imported, we can proceed to create the mesh using the GMSH program.

To run the plugin, on the the Plugins menu, click Generate TriMesh, or click on the icon:

The following figure shows the generated mesh. You will also see in the Layers panel two new
layers: Trimesh and Trimesh_point:
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Figure 12.7 – Resulting mesh.

Before using the Export plugin, save the QGIS project. To accomplish this, from the Project menu,
click Save. Name the project file ‘UrbanDrainageTutorial.qgz’.

12.2 Exporting the files
Once the layers with the input information to the model have been created, the next step is to export
from QGIS the data files required by the RiverFlow2D model.

1. Run the Export RiverFlow2D plugin

2. A dialog window is presented. We must indicate the raster layer of the Digital Elevation Model
(DEM), as this layer is not created by the plugin and its name may be different.

3. Using the “…” button, select the path, and enter the file name. Please, ensure that the path is
the same as that previously selected, and the one corresponding to the ‘.qgz’ project file.

4. Click OK.

Export RiverFlow2D dialog.

The plugin will begin to process the information. A message bar at the top will indicate the
approximate progress of the process.
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Once the process of creating the files with the input data is finished, the Hydronia Data Input
Program is opened automatically and a dialog window is presented with the model project to
run. In this case: ‘base.DAT’ should already be set.

Then the window with the input parameters of RiverFlow2D is presented, as shown in the
image below:

Hydronia Data Input Program window.

Enter 5 hours for the Simulation time and click on the Storm Drain EPA-SWMM panel. Enter
for the N1 node CD = 0 since we don’t want exchange with that inflow node to the conduit.

Storm Drain Dialog.

5. Click [Save .LWSMM] and overwrite the existing file, for this tutorial the filename will be the
name of the project when it was exported with the ‘.lwsmm’ extension.

6. Click the Run RiverFlow2D button to run the model. The model will show a window reporting
on the model progress.
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Morel Report Window.

When the run finishes, close the window and you can import results back in QGIS to prepare
maps and animations. An example of the maximum depths is shown below:

Maximum depths.

This concludes the Urban Drainage using RiverFlow2D and EPA-SWMM tutorial.
 



13
Simulating a tailings dam failure with

RiverFlow2D MT

This tutorial will show how to set up a tailings dam failure simulation with the RiverFlow2D model
with the Mud and Tailings Flow Module (MT) using the QGIS interface. The exercise consists of
modeling a tailings dam failure flood and creating results maps for the impacted areas. The data is
based on the Brumadinho dam disaster occurred on 25 January 2019 when a tailings dam at the
CA3rrego do FeijAśo iron ore mine, east of Brumadinho town, in Minas Gerais, Brazil, suffered a
catastrophic failure.

The files required to follow this tutorial can be extracted from the ‘ExampleProjects’ zip file under the
‘BrumadinhoRF2D’ folder. This zip file is downloaded separately from your installation materials.

118
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Figure 13.1 – Files with data required for the example.

13.1 Start a new project for a tailing dam break
simulation

1. To create a new RiverFlow2D project, open QGIS and click on the New RiverFlow2D Project

button in the toolbar. A dialog window appears where you select the layers that will be
created, the name of the Senario, the Coordinate Reference System (CRS), and the directory
path where the layers will be saved. This example will use the layers: Domain Outline, Manning
N, BoundaryConditions, MeshDensityLine, and InitialConcentrations.

2. Select None in the Layers drop-down menu, then click the MeshDensityLine and the Initial
Concentrations check boxes.

3. Click the Projection button and in the Filter text box, type 31983 and select the Coordinate
Reference System and click OK as shown:
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Coordinate Reference System Selector dialog window.

4. Click the button to provide a path to store the project files in the Project Directory text
box. This will be the folder where the model will write all results and output files. Browse to
the tutorial directory in the location where the files were extracted, in the ‘BrumadinhoRF2D’
folder, then click Select folder. The dialog window should look like the following:

Create new project window.
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5. After clicking OK, the layer templates are created, and displayed on the Layers Panel

Layers created for the project.

On the QGIS Project menu, click Save, to save the project in the same directory that you
previously selected in the Create New Project dialog above.

13.2 Load elevation data
In this tutorial we will use two Digital Elevation Model or DEM raster files that contain the terrain
elevation data and tailings dam volume data.

1. To load the DEMs, click the Add Raster Layer button . You may also use the QGIS shortcut
Control+Shift+R.

2. In the dialog search for the tutorial folder and select the ‘RasterBRUMADINHO.tif’ and ‘Ras-
terDAM10.tif’ files as shown:

Dialog to create a layer from a raster file.

3. Click Add and then Close.
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4. Click on the RasterBRUMADINHO layer. Use the Zoom to Layer button to center the
image.

The raster will be displayed on the screen, by default it is rendered in gray gradient as shown.

Digital elevation model in raster format.

Right-clicking on the label of the new raster layer and selecting Properties, in the Symbology
panel you can change the Render type for a more informative palette such as Hillshade for
instance.

Digital elevation model with Hillshade render.

You may move the raster layer by dragging it to the end of the list of layers to avoid that it would hide
or interfere visually with the other layers.
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13.3 Create the limits of the modeling area
We define the limits of the modeling area drawing a polygon on the Domain Outline layer. To create
it do as follows:

1. Click the Domain Outline layer to activate it and then click Toggle Editing (pencil) in the toolbar

2. Click the Add Polygon Feature tool . Proceed to delineate the outline of the polygon by
clicking the vertices with the left mouse button.

3. To finalize and close the polygon, right-click on the map view area. A dialog window to input
the cell size attribute of the newly created polygon will appear. The CellSize value for the
reference size of the mesh cell is indicated. Enter a value of 50 m.

The Domain Outline should look similar to the following figure:

Domain Outline polygon.

4. Save the polygon by clicking the Save Layer Edits button .

5. Click on Toggle Editing button to deactivate the layer Edit mode
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13.4 Create more detail for the mesh down the main
flow area

Once the Domain Outline is created, a Mesh Density Line will provide the necessary detail down
the main channel for more accuracy.

1. Select the MeshDensityLine layer making sure it is activated as shown

and click the Toggle Editing button .

2. Click the Add Line Feature button then Left-click to draw the points down the middle of
the channel all the way to the river entrance at the bottom of the Domain Outline.

3. Right-click to finish the line. A dialog requesting input for the MeshDensityLine Feature At-
tributes will appear. Input 25 as the CellSize for the MeshDensityLine layer. The first line
should look as follows:

First mesh density line.

Another line will need to be drawn to finish adding detail down the main path on the river in the
south.

4. Click the Add Line Feature button then Left-click to draw the points starting from the the
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south-western part of the Domain Outline along the riverbed and right-click to finish the line,
joining it to the first line as follows:

Second mesh density line.

5. Right-click to finish the second line. A dialog requesting input for the MeshDensityLine Feature
Attributes will appear. Input 25 as the CellSize for the MeshDensityLine layer.

6. Save the polygon by clicking the Save Layer Edits button .

7. Click on Toggle Editing button to deactivate the layer Edit mode

The finished MeshDensityLine layer should look as follows:

Finished MeshDensityLine layer.
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13.5 Generating the triangular-cell mesh
Now that the Domain Outline and Mesh Density Line layer have been created, proceed to generate

the mesh by clicking on the Generate Trimesh button.
The following figure shows the generated mesh. You will also see in the Layers panel the new layer:
Trimesh

Figure 13.2 – Triangular mesh generated for the tailings dam break tutorial.

13.6 Setting up the boundary conditions
Here we will explain how to enter boundary conditions that are needed in any inflow or outflow
sections of the model area where flow can enter or leave the mesh. In this tutorial we will have one
inflow and one outflow condition.
We first enter the inflow boundary condition imposing a hydrograph (discharge vs time).

1. Select the BoundaryConditions layer in the Layers panel.

2. Click the Toggle Editing button to add the polygons that will indicate the open boundary
segments where inflow and outflow conditions are imposed. Draw a polygon at the bottom
end of the mesh as indicated in the figure:
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Polygon that covers the nodes defining the Inflow boundary condition segment.

3. To finish the polygon, right-click on desired location. A window to enter the attributes of the
newly created polygon is displayed.

The exact form of the polygon is not important. You only need to make sure that the polygon
covers the segment length at which you want to impose the condition. All cells falling within
that polygon will be open boundary cells.

4. In the Boundary Cond. ID enter the desired name or leave the default.

5. Select 2. Discharge vs. Time from the Type of Open Boundary list.

6. Click Import BC File button, and search for the ‘inlet1.QVT’ hydrograph file as shown below:

Inflow boundary condition parameters.
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Hydrograph loaded from the ’inlet1.QVT‘ file.

7. Click OK to close the dialog and then click Save Layer Edits .

All boundary condition files, such as ‘inlet1.QVT’ in this tutorial, need to be in the same directory as
all the other project files.
Now we will enter an free outflow condition where the fluid will be let to flow out from the mesh.

1. Click the Add Polygon Feature tool . Proceed to delineate the outline of the polygon by
clicking the vertices with the left mouse button. Draw the polygon defining the outflow boundary
area at the downstream end of the river as shown:

Polygon that defines the outflow boundary condition segment.

2. Right click to close the polygon. A dialog window will appear to enter the parameters. Select
the condition type Uniform flow condition and set So to 0.005. The dialog should look like the
following:
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Parameters for the free outflow open boundary condition.

3. Save the changes made to the layer by clicking the Save Layer Edits button .

4. Deactivate editing mode by clicking on the Toggle Editing button .

The figure below shows how the BoundaryConditions layer should look:

Polygons that define the inflow and outflow boundary conditions.

13.7 Assigning Manning’s n
Manning’s n is the parameter determining the bed roughness. The model requires that all cells in
the model area have a defined n. In a project application we should have n’s that vary through the
mesh since variable vegetation and terrain characteristics will have different roughness. However,
for simplicity, in this tutorial we will assume a single n.
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1. Select the Manning N layer and click the Toggle Editing button .

2. Click the Add Polygon Feature to draw a polygon that covers the entire domain. The
polygon may extend beyond the mesh area as shown:

Manning N layer.

3. Close the polygon by right-clicking on the end vertex and enter a Manning’s n equal to 0.035:

Dialog to input ManningN.

4. Click Save Layer Edits , and then click the Toggle Editing button to deactivate editing
mode.

13.8 Providing the Initial Concentrations for the tailings
material

The RiverFlow2D MT model allows defining initial volume concentrations that vary in space. In order
for the model to assign this initial state, one or more polygons must be drawn over the tailings raster
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or initial water surface elevation polygon. This polygon will then be assigned a data table attribute
that gives the concentrations for each sediment class.

1. Select the InitialConcentrations layer in the Layers and click the Toggle Editing button

2. Click the Add Polygon Feature button and draw the polygon, keeping within the edges of
the RasterDAM10 raster:

Initial Concentrations polygon.

3. An InitialConcentrations - Feature Attributes dialog will appear. On the Initial Concentrations
File line click the Browse button to select the ‘Deposit_Initial.txt’ file from the project folder
‘\ExampleProjects\BrumadinhoRF2D\base\’ folder and then click OK.

4. The dialog should look like the following:

Initial Concentrations - Feature Attributes dialog.

5. Save the changes made to the layer by clicking the Save Layer Edits button .

6. Click the Toggle Editing button to disable editing mode.

Save the QGIS project using the Save Project button or by using the Project menu. Name the project
file ‘Brumadinho.qgs’.
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13.9 Exporting the project from QGIS to RiverFlow2D
Once the layers with the input data to the model have been created, we need to export data files
required to run RiverFlow2D.

1. In the RiverFlow2D plugin toolbar, click the Export files for RiverFlow2D button and select
Export RiverFlow2D …

2. In the export dialog window indicate the Project Name, Brumadinho in this tutorial.

3. In the drop-down menu for DEM Single Raster select RasterBRUMADINHO

4. Click on the Options arrowhead to view the additional parameters for the export.

5. under DEM (Single Raster) make sure RasterBRUMADINHO is selected in the dropdown
menu.

6. Click to enable the checkbox for Using Initial WSE Raster Layer, then on the drop down menu
select the RasterDAM10 as your InitialWSE layer.

Your Export RiverFlow2D dialog window should look like this:

Parameters for the Export to RiverFlow2D dialog.

7. Click OK.

13.10 Configure final model parameters in the Hydronia
Data Input Program (DIP).

Once the model files have been created, the Hydronia Data Input Program will appear automatically
with the main control data file loaded, in this case: ‘Brumadinho.DAT’.
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13.10.1 Control Data Panel
The following parameters will need to be changed as indicated:

1. In the Control Data panel under the Time control data section, Set the Output interval (hrs.):
to 0.01.

2. In the Modules section click the Mud/Tailings Flow radial button.

*Optional* If you have an nVidia graphics card installed on the system, you can enable the
RiverFlow2D GPU under the Model Selection section to accelerate the computation speed for
the simulation.

The Control Data panel should look like the following:

Hydronia Data Input Program window with Control Data parameters for the tailings dam break
tutorial.

3. Click the Save .DAT button. Click Save again in the dialog box and click Yes to replace the
existing file.

13.10.2 Mud/Tailings Flow Panel
The Mud/Tailings Flow module needs to be configured with the tailings properties and other rheo-
logical parameters. Please do the following:

1. Click on the Mud/Tailings Flow on the left side panel to activate it.

2. In the Mud/Tailings Flow panel, click the Open .MUD button.

3. A dialog will appear asking for a file ending with the ‘.MUD’ extension. Browse for the file
‘\ExampleProjects\BrumadinhoRF2D\base\brumDam.MUD’ and click Open.

You will now see that the panel has changed most of the parameters. More importantly, the
Variable properties-Erosion-Deposition Model has been enabled, and there are six sediment
classes loaded. Take some time to familiarize yourself with the parameters.
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The parameters that have been loaded need to be saved with the same name as the project
name so that the model will use it upon execution.

4. Click the Save .MUD button and the Scenario name ‘base.MUD’ should already be set. Click
Save.

The Mud/Tailings Flow panel should look like the following:

Hydronia Data Input Program window with Mud/Tailings Flow parameters for the Brumadinho
Tutorial.

13.10.3 Providing the Viscosity and Yield Stress data for
Variable properties-Erosion-Deposition Model

When selecting to use the Variable properties-Erosion-Deposition Model in this tutorial, data
tables for the volume concentrations relationship with Viscosity and Yield Stress need to be
provided. These files are already prepared for this tutorial, and must be copied into the Sce-
nario folder as follows:

1. In File Explorer browse to the location of the project folder ‘\ExampleProjects\BrumadinhoRF2D\’

2. Select the following files from the folder: ‘YieldStressVsCv3.txt, ViscosityVsCv3.txt’

3. Copy the files into the Scenario folder ‘\ExampleProjects\BrumadinhoRF2D\base\’

13.10.4 Updating the Inflow Boundary Condition File

It is critical to update the Open Boundary Conditions data file with additional columns of data
that represent the new sediment classes. By default this file contains a table of time and
discharges, but the model requires for all inflow conditions the volume concentration for each
sediment or material class. In case of water flow, all concentrations must be set to 1. To
update it do the following:
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5. Click on the Open Boundary Conditions under Components in the side panel of the Hydronia
Data Input Program.

6. Click on the cell in the first table that contains the ‘inlet1.QVT’ variable:

Section containing table with Boundary Conditions set for this run.

Upon clicking the cell, a dialog box should appear that will allow us to automatically update the
existing data table in the ‘inlet1.QVT’ file with the additional rows needed, and setting each to
0:

Dialog for correcting the Boundary Conditions file automatically.

7. Click Yes to update the ‘inlet1.QVT’ file.

You can verify the contents have been updated by scrolling to the right in the file contents sec-
tion or by opening the ‘\ExampleProjects\BrumadinhoRF2D\base\inlet1.QVT’ file in Windows
Explorer. Your Inlet1.QVT file should look like the following figure:

Contents of the updated Inlet1.QVT file.

13.11 Running the model
The simulation is now ready to run. Proceed as follows:

1. Click on Control Data in the side panel of the DIP and then click the Run RiverFlow2D button
at the bottom.

2. The DIP will ask to save changes to the .DAT file, click No.

A few windows should appear, the last one will be the graphical model windows that displays
the status of the model. When the model is finished running, it should look as follows:
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RiverFlow2D model execution window.

3. Click Close and let the program finish writing the remaining output files.

13.12 Generating maps for the Mud/Tailings Flow
module

Once the model has finished running we can create maps for various outputs. This tutorial will focus
on some of the specific maps that can be generated once the Mud/Tailings module with variable
properties-erosion deposition enabled.

1. In QGIS , in the RiverFlow2D plugin toolbar, click on the drop down menu for Results vs Time
Maps and select Concentrations and Properties vs Time Maps

Concentrations and Properties vs Time button in RiverFlow2D Plugin toolbar.

The Concentrations and Properties vs Time Maps window will provide maps for each Sediment
class, labeled Conc_# under the Maps subsection. Users can also create maps for each of
the variables in the list.

2. Select one of the Maps, then select an Output Times of interest. You can hold Control key
while clicking on multiple Maps and / or Output Times.
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3. Once all outputs of interest are selected, click on the Right Arrow button to move them to
the Output Maps subsection.

Concentrations and Properties vs Time Maps window.

4. Click the OK button to generate the maps.

The Layers panel on the left side will have a group named OUTPUT RESULTS where the
resultant map or maps will be placed.
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Figure 13.3 – Results map of Conc_1 at hour 2.

Repeat these steps to create maps for each of the concentrations if desired.

13.13 Generating animations for the Mud/Tailings Flow
module

An animation can best illustrate the mud / tailings flow over time. This section will show how to
generate results for the specific variable properties-erosion deposition enabled model outputs.
On the QGIS Project menu, click Save, to save the project in the same directory that you previ-
ously selected in the Create New Project dialog above. This is required for the Animations panel to
function.

1. Start by activating the Animations panel in the RiverFlow2D plugins toolbar

A panel will appear below the Layers panel on the bottom left.

2. Click on the Select layer drop-down menu and select Mud/Tailings Flow.

3. Click Add Layer. A dialog box will appear asking for the specific Animation we would like to
create:
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RF2D Animation dialog window.

4. Click on the drop-down menu to see the available outputs. They will be the same as the ones
from Concentrations and Properties vs Time Maps plugin.

5. Choose any of these and click OK.

6. Select the output range desired, or just leave the default for the entire range of output intervals.
Click OK

There is a status bar underneath the Select layer drop-down showing the progress of the
animation generation. When it is finished, the layer previous choice of animation will appear
in the box underneath the status bar.

RF2D Animation panel indicating the status bar and generated animation layer.

7. Click and hold to drag the newly created ANIMATION group in the Layers panel and move it
above the Raster layers so that the animation will be visible.

8. Click on the layer that was generated in the RiverFlow2D Animation panel then click the Play
button to view the animation.

Repeat these steps to create animations for each of the concentrations if desired.

This concludes the tutorial for Simulating tailings dam Failures utilizing the Mud/Tailings Flow module
in RiverFlow2D.
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Simulating Pollutant Transport

RiverFlow2D contains the Pollutant Transport module that simulates the movement and transfor-
mation of pollutants in a water body. It can account for various processes that affect the fate of
pollutants, such as:

• Dissolved substance transport (Solutes)

• Advection-Dispersion-Reaction

• Thermal analysis

• Decay over time

• Multiple pollutants

• Reaction rates between pollutants

In this tutorial we will go through the step-by-step process of creating a simple scenario with pollu-
tants on the Magdalena River in Columbia to show how the model is used to solve these types of
cases. In this tutorial we will:

1. Open an existing RiverFlow2D project.

2. Create a scenario for a single pollutant.

3. Create an Initial Concentrations layer.

4. Enter pollutant data.

5. Generate the mesh and Export the files to RiverFlow2D.

6. Run the RiverFlow2D model.
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7. Review the output files.

The files required to follow this tutorial can be extracted from the ‘ExampleProjects’ zip file under the
‘SimulatingPollutants’ folder. This zip file is downloaded separately from your installation materials.
Please refer to the RiverFlow2D Reference Manual for additional specifications and requirements
to run the Pollutant Transport model.

14.1 Create a scenario to model a single pollutant as an
initial condition

There are a few layers involved with handling the introduction of pollutants in the areas of interest,
depending on the conditions that will be simulated. For this section, we will create a scenario named
SinglePollutant that will showcase a an existing pollutant that is already present initially and is part
of the discharge of the river. The water body will be utilizing an Initial Concentrations layer to have
the desired concentration for the same pollutant present.

1. In QGIS, in the File menu click Open. Browse to the tutorial folder and select the ‘Simulating-
Pollutants.qgz’ project and click [OK].

2. In the RiverFlow2D toolbar click on the New Project button and select New Scenario:

New Scenario button location.

3. Type “SinglePollutant” without quotes as your new scenario name. A copy of the current project
will be made and kept in a separate subfolder named “SinglePollutant”

New Scenario input dialog window.
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14.2 Create an Initial Concentrations layer.
1. In the RiverFlow2D toolbar, click on the dropdown button for RF2D tools and click New Tem-

plate Layer:

New Template Layer button location.

2. In the Add Layer Template dialog window, select the InitialConcentrationsPollutant checkbox
and click [OK].

Add Layer Template window with InitialConcentrationsPollutant selected.

A new layer should appear in the Layers panel on the left-hand side:
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Layers panel with InitialConcentrationsPollutant selected.

We need to create a polygon in the Initial Concentrations layer that covers all of the river. We
can utilize the Domain Outline layer and copy the same polygon into our newly created layer.

3. Select the Domain Outline layer in the Layers panel.

4. Click on the Select Feature by Area or Single Click button, then click inside of the
Domain Outline polygon in the map area to highlight it:

Map area with Initial Concentrations selected.

5. Click the Copy Features button from the QGIS toolbar.

6. Select the Initial Concentrations layer in the Layers panel and click on the Toggle Editing
button to put the layer in edit mode.

7. Click the Paste Features button.

14.3 Enter pollutant data.
1. Right-click the InitialConcentrationsPollutant layer in the Layers panel and select Open At-

tribute Table.

2. In the InitialConcentrationsPollutant features window, click on the [Browse] button for the Initial
Concen field.



14.4 Generate the mesh and Export to RiverFlow2D 144

3. In the project folder, browse into the project folder and select ‘InitialConcentration.txt’, copy it,
then go back to the main project folder and browse to the SinglePollutant folder and paste it
there. Click on the file again and click [Open].

4. Close the InitialConcentrationsPollutant Features dialog window.

5. Click the Save Layer Edits button then click the Toggle Editing button.

14.4 Generate the mesh and Export to RiverFlow2D

1. Generate the mesh by clicking on the Generate TriMesh with elevations button in the
Generate TriMesh menu:

Generate Trimesh with Elevations menu location.

Ensure that the “Magdalena” DEM is selected in the Raster Layer List dropdown.

2. Export the project to RiverFlow2D by clicking the Export RiverFlow2D button in the RF2D
toolbar.

3. You will be presented with the Export Files to RiverFlow2D dialog. Leave all parameters as
they are and click [OK].

Export Files to RiverFlow2D dialog window.

We want to start the model with a body of water present in the river channel. Since this area
is below sea level, we will set a horizontal water surface elevation to provide water below that
level in the DIP.

4. The Hydronia Data Input Program will open. Under Modules select the Pollutant Transport
radio button. Under Initial conditions section, click the Horizontal water surface elevation radio
button, leaving it at 0 then and click on Pollutant Transport on the left side panel:
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Hydronia Data Input Program dialog window.

5. In the Name section double click in the empty cell and write Pollutant1, then set the P1 column
value for the row to 0.

The Pollutant Transport panel allows the user to control Dispersion coefficients for all pollu-
tants, as well as define the decay rate for each pollutant. We want to set the decay rate to 0
and leave the rest as default.

Pollutant Transport panel.

6. Click on the [Save .SOLUTES] button, it will use the name of the scenario ‘A.SOLUTES’. Click
[OK] to save the file.

14.5 Review Boundary Condition Panel for Pollutant
Inflow

The pollutant we have specified will be arriving via the inflow boundary condition that was present
in the base tutorial files.
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The pollutant concentration units are arbitrary. Your can use volume concentration Cv (fraction of
1), mg/l, ppt, ppm, or any other suitable units, provided that the inflow boundary conditions are
consistent.
You can view the boundary conditions file to see the additional column that is required, noting the
additional column present in the ‘QIN2.DAT’ file:

1. Click on the Open Boundary Conditions panel on the left-hand side.

Boundary Conditions panel.

2. Switch back to the Control Data panel and click [Save .DAT]. Replace the existing ‘SinglePol-
lutant.dat’ file to save the changes made earlier.

3. Click [Run RiverFlow2D] to execute the model.

14.6 Review the output files

The output maps for pollutants will show us the concentrations over the model domain. We will use
the Concentrations and Properties vs. Time Maps tool to generate them.

1. In QGIS, Click on the button and select Concentrations and Properties vs. Time Maps.

2. in the Concentrations and Properties vs. Time Maps dialog window, click the [. . .] button and
select the ‘A.SOLUTES’ file and click [OK].

3. Select Conc_1 under Maps, then select the last output time, then click the [→] button to make
the selection. You may also hold the control key and select multiple output times. Click [OK]
when ready.
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Concentrations and Properties vs Time Maps dialog window.

Output map for Pollutant 1.
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14.7 Create a second scenario for adding a new
pollutant source under existing conditions

We will now create a new scenario to test having an additional separate pollutant enter the river from
a specific point by utilizing a Sources/Sink layer.

1. In the RiverFlow2D toolbar click on the New Project button and select New Scenario:

New Scenario button location.

2. type “MultiplePollutant” without quotes as your new scenario name. A copy of the current
project will be made and kept in a separate subfolder named “MultiplePollutant”

3. In the RiverFlow2D toolbar, click on the dropdown button for RF2D tools and click New Tem-
plate Layer:

New Template Layer button location.

4. In the Add Layer Template dialog window, select the Source/Sink checkbox and click [OK].
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Add Layer Template window with Sources/Sink selected.

A new Sources layer will appear on the lefthand Layers panel, under the COMPONENTS
group.

5. Select the Sources layer and click the Toggle Editing button.

We want to place the second pollutant in the middle of the river, ideally somewhere away from
our inflow.

6. Click the Add Point Feature .

7. Place the point by clicking on the desired location. A dialog window will appear to enter the
source information:

Sources -Feature Attributes General tab.

8. Select 1.Discharge vs Time under Source/Sink type. Click the Data tab.

Your sources file has to exist in the MultiplePollutant folder, we must copy the one created for
this tutorial into the current scenario folder.

9. Browse by clicking the [Import Source/Sink File] button. Browse to the project base scenario
directory at ‘/SimulatingPollutants/base’ and copy the ‘Source2_Pollutant.txt’ file.

10. Browse back to the current scenario folder in ‘SimulatingPollutants/MultiplePollutant’. Paste
the copied file into this directory. Select the copied file ‘Source2_Pollutant.txt’ then click [OK]
twice to save the Sources information.

11. Click the Save Layer Edits button then click the Toggle Editing button.

12. Export the project to RiverFlow2D by clicking the Export RiverFlow2D button in the RF2D
toolbar. Leave all default values.
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14.8 Adding required multiple pollutants concentrations
information

This section will explain how to edit inflows and initial concentrations needed in the current Scenario
B in order to run the simulation with multiple pollutants.

We need to copy the ‘InitialConcentration.txt’ file from our project folder into our current scenario:

1. In File Explorer, browse to the ‘ExampleProjects/SimulatingPollutants/’ and copy the ‘Initial-
Concentration.txt’ file.

2. Browse to ‘ExampleProjects/SimulatingPollutants/MultiplePollutant’ and paste the file.

3. Double-click the ‘InitialConcentration.txt’ to edit the contents in Notepad.

This file needs to contain a second column indicating there is a second pollutant, with 0 con-
centration. You can set this to be any concentration

4. Add a 0 next to the current one, they can be separated by a space or tab. It should look like
this:

InitialConcentrations.txt file with edits.

5. Save the file and close it.

6. In File Explorer, double-click on ‘QIN2.txt’ to edit it in Notepad.

7. Add a fourth column of data starting on the second row. We will set the inflow for this pollutant
to 0 since we only want one pollutant entering the through the inflow boundary condition:
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Boundary Condition inflow file with additional pollutant inflow set to 0.

14.9 Add the new pollutant parameters in the Hydronia
Data Input Program then Run the RiverFlow2D
model

Before running the model we will need to ensure that some additional settings are saved.

1. In the Control Data panel under the Modules section, ensure that Pollutant Transport is en-
abled.

2. In the Components section, ensure that Sources/Sinks is enabled.

3. Under Initial conditions, ensure that the Horizontal water surface elevation radial button is
enabled and has a 0 value, then and click on Pollutant Transport on the left side panel.

We need to add our second pollutant information.

4. Under the Name section below Pollutant1, then create an additional pollutant by double-
clicking in the empty row and set the P2 column value for the second row to 0. Your Pollutant
Transport panel should look as follows:
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Pollutant Transport panel with two pollutants set.

5. Click on the [Save .SOLUTES] button, it will use the name of the scenario ‘MultiplePollu-
tant.SOLUTES’. Click [OK] to overwrite the existing file.

6. Click on the Sources and Sinks button on the left side panel.

7. Click [Open .SOURCES]. Select the ‘MultiplePollutant.SOURCES’ file. You should see the
table for the new pollutant source discharge on the 4th column.

Sources and Sinks panel with new pollutant source added.

8. Click on Control Data on the left side panel.

The Control Data panel should have the following parameters set:
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Hydronia Data Input Program with Scenario B settings.

9. Click [Run RiverFlow2D]. When asked to save, click [Yes] to overwrite the MultiplePollutant.DAT
file with the changes made in the Hydronia Data Input Program.

Once the model is finished running, you can follow the same steps outlined in the Review output
files section of this tutorial. You will notice there are two concentrations in the list. The output for the
new source Conc_2 should look something like this, depending on where you placed your source:

Figure 14.1 – Concentrations map for Conc_2 in scenario MultiplePollutant.

This concludes the tutorial for simulating pollutant transport with RiverFlow2D.
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Wind driven circulation

RiverFlow2D and OilFlow2D allow defining wind velocity on the water surface to account for the
effect of the wind stress on the flow velocities. The conceptual model of a wind driven simulation
require a series of non-overlapping polygons that determine the wind velocity data to the model. Only
areas covered by polygons will be affected by the wind stress. Each wind velocity polygon should
be associated with a file containing a wind velocity time-series file containing the two components
of the wind velocity vector for each time. The user will need to generate the wind velocity data file
associated with each polygon, and copy them to the project folder, prior to running the model.
This tutorial illustrates how to perform a wind drive simulation using the QGIS interface. The proce-
dure includes the following steps:

1. Create time series data for wind speed.

2. Open an existing RiverFlow2D / OilFlow2D project.

3. Create the template of the wind layer and the wind speed polygons.

4. Generate the mesh.

5. Running the model.

6. Review wind output files.

The files required to follow this tutorial can be extracted from the ‘ExampleProjects’ zip file under
the ‘WindTutorial’ folder. This zip file is downloaded separately from your installation materials.

15.1 Open an existing project
1. Open QGIS
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2. On the Project menu click Open… to load the existing project: ‘WindTutorial.qgz’.

This project contains the layers of the domain contour and the layer of the Digital Elevation Model
(DEM) of Lake Champlain in the USA. When the project is opened, a project image will be loaded
in QGIS as shown in Figure 15.1.

Figure 15.1 – Example of the tutorial loaded in QGIS.

15.2 Wind velocity time-series data file
To run a wind driven simulation you create polygons over which the wind velocity data will be applied.
Each polygon will have an associated velocity time series. These files can be created with any text
editor such as Notepad or Wordpad. The wind velocity file has the following format:
Line 1: Number of points in the time series of wind velocity
NP
NP lines containing:
TIME Wvx Wvy
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where Wvx and Wvy, are the wind velocity components in x and y directions respectively in m/s or
ft/s.

The following table is an excerpt of the ‘WindVelocDATA.TXT’ file that is included in the Data folder
for this tutorial:

6544
0 5.97 −2.17
1 5.09 8.83
2 3.84 6.63
3 5.87 4.92
4 0.00 0.00
5 −3.31 −1.90
. . .
6543 3.84 −6.63

15.3 Create the template for the wind layer and the wind
speed polygons

To add the template where the polygons are drawn with the wind speed time series data involves
the following steps:

1. Create the template for the Winds layer: In the model toolbar click on the New Template Layer
command

2. In the plugin window, activate the Wind checkBox, as shown in the Figure below:
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Plugin to add a New Template Layer.

3. Edit the Wind layer: In the layers panel, we select the Wind layer and in the digitalization

toolbar we click on the Toggle Editing tool . A pencil icon will appear in the Wind layer,
indicating that the layer is in edit mode:

4. Draw the polygon that demarcates the Wind area: Using the Add Feature tool from the digi-

talization toolbar .

Draw the polygon that defines the wind area. In this case, the tracing of the polygon must be
done in such a way that it covers all the cells of the mesh. Once you finish drawing the polygon
a window to input the polygon parameters is immediately opens, which are three:

• Wind stress coefficient CD: 0.009,

• Air density: 1.225, and

• Wind speed time series File: ‘WindVelocDATA.txt’.

The parameter window should be as shown below:
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Window to input the Wind polygon parameters.

5. After input the values, click OK and accept the changes. There should be an image similar to
the one shown in the following figure:

Wind layer polygon.

15.4 Generate the mesh

Then the mesh is generated with the Generate TriMesh button

The results obtained as shown in Figure 15.5 (mesh of around 17,500 cells).
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Figure 15.2 – The resulting mesh.

15.5 Exporting files
Now that the mesh is generated and the other layers are ready with the necessary data, export the
files in the format required by the model.

1. Uncheck the Boundary Conditions layer.

2. Click on the Export button
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3. In the dialog, select the raster layer that contains the Digital Elevation Model (DEM) and the
name of the project to be exported.

4. Use the Zoom Full button to center the image.

5. Before executing the plugin activate the DEM layer (if it is deactivated).

Once the plugin is executed, a window will be shown (Figure 10.6) as it should be for our
example.

Plugin window to export the files.

6. Click on the OK button.

15.6 Running the model
After exporting the files, Hydronia Data Input Program is loaded with the project file from the ‘Wind-
Tutorial.DAT’ example and shows the Control Data panel.

1. Enter the information as illustrated in Figure 15.7

Hydronia Data Input Program Control data panel.
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2. Verify that the Wind component is selected.

3. Select the Wind component from list in the left side of the panel. The window with the infor-
mation of the wind parameters will appear as can be seen in the figure below:

Hydronia Data Input Program Wind panel.

4. Verify that the simulation time is set to 24 hours and the output interval is set to 0.5 hours.

5. Verify that the Initial conditions is set to Horizontal water surface elevation and 0 on the text
box. Leave all other parameters at their default values.

6. Click on the Run RiverFlow2D button in the lower section of Hydronia Data Input Program.

7. Click on the Run OilFlow2D button in the lower section of Hydronia Data Input Program.

8. Save the changes with the same name as the ‘base.DAT’ file, then a window will appear
indicating that the model started running.

The model window that appears during the run model shows several runtime parameters.
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Figure 15.3 – Model window.

15.7 Check the wind output files

The model creates the following files for each output time as defined in the Control panel:

‘CELL_TIME_METRIC_DDDD_HH_MM_SS.TEXTOUT’ (Metric Units) or

‘CELL_TIME_ENG_DDDD_HH_MM_SS.TEXTOUT’ (English Units)

where DDDD indicates the day, HH, hour, MM minutes and SS seconds.

In these files, columns 1, 2 and 3 report the velocity components in Vx, Vy and the module respec-
tively. We can visualize the water velocity fields generating layers either in raster or vectorial format
from the aforementioned files using the Maps of Results vs Time tool.

The following figure shows the water velocity field map for time 0000:20:00:00:
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Figure 15.4 – Map with the speed field for the time 20 hours.

This concludes the Wind driven circulation tutorial.
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Using Manning’s n ESRI shape files

This tutorial illustrates how to use Manning’s n files in ESRI shape file format to assign Manning’s n
values to an existing project using the QGIS interface. The procedure includes the following steps:

1. Open an existing RiverFlow2D project.

2. Load the shape files with the Manning’s n polygons.

3. Import the Manning’s n geometry and values to the Manning N layer.

The files required to follow this tutorial can be extracted from the ‘ExampleProjects’ zip file under
the ‘ManningsNShapefileTutorial’ folder. This zip file is downloaded separately from your installation
materials.

16.1 Open an existing project
1. Open QGIS

2. On the Project menu click Open… and browse to the existing project: .

This project contains the layers of the domain contour, the Digital Elevation Model (DEM) of the
river bed in raster format, an aerial photograph, and the boundary conditions layer where the
inflow is located in the upper right and outflow in the lower left. The inflow boundary condition
is a hydrograph with a peak discharge of 220,000 ft3/s, and the outflow conditions is set to
Free outflow. When you open the project you will have an image of the project loaded in QGIS
as shown in 16.1.
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Project loaded in QGIS.

16.2 Load the shape file with the Manning’s n polygons
1. In order to load the shape file with the polygons containing the Manning’s n values, click on

Add Vector Layer button

of Manager layer toolbar or from the main menu Layer → Add layer → Add Vector Layer…

2. In tutorial folder under the base subfolder, select the ‘SaltRiver_ManningsN.shp’ file (Figure
16.2).

Window to find and open the shape file.
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When loading the file, an image similar to the one shown in the following figure will be displayed
on the screen:

SaltRiver_ManningsN Layer.

16.3 Import the Manning’s n geometry and values to the
Manning N layer

To transfer spatial and attributive information from the shape file to the Manning N layer, a copy and
paste operation is performed, but it must be ensured that both layers have a field or column with the
same name. The procedure is as follows:

1. Check the fields name of shape file: Right-click on the SaltRiver_ManningsN layer label and
in the pop-up menu select the option Open attribute table (Figure 16.4).
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Attribute table of the SaltRiver_ManningsN layer.

You can see that the shape file loaded has two fields, LUCode and N_Value, the first one with
the coding of the land cover type and the second corresponds to the value of the Manning’s
n, in the case of the Manning N layer, it has a single field called ManningN.

2. Proceed to change the name of the field N_Value to ManningN. Close the table of attributes
and right-click on the layer label. In the pop-up menu, select Properties then in window that
opens select the Fields tab as shown in Figure 16.5:

Properties the SaltRiver_ManningsN layer.

3. Click on the Toggle Editing button

then change the N_Value field name by ManningN (Figure 16.6), and click on the Toggle
Editing button again, and save.
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Field properties of the edited SaltRiver_ManningsN layer.

4. Copy the polygons of the shape file: select the SaltRiver_ManningsN layer in the Layers Panel.

5. With the select tool we draw a rectangle that covers the entire layer:

Selecting all the polygons in the SaltRiver_ManningsN layer.

6. Copy the spatial elements by clicking on the Copy button of the digitization toolbar

7. Paste the spatial elements in the Manning N layer: select Manning N layer of the Layers Panel

and set it in edit mode by clicking on the Toggle Editing button .

8. Click on the Paste Feature button .
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and a message will appear that indicates that features were successfully pasted.

9. Click on the Toggle Editing button again .

Confirm and save the changes made to the layer.

To verify the operation was successful, open the attribute table of the Manning N layer and you can
see that the polygons have been copied with their Manning n values. As shown in the Figure below:

Figure 16.1 – Attribute table of the Manning N layer.

You can now remove the SaltRiver_ManningsN layer from the Layer Panel.
This concludes the Using Manning’s n ESRI shape files tutorial.



17
Post-processing calculations

RiverFlow2D has three output controls that make it easier for the user to analyze the results of the
runs at specific sites in the domain calculator. These output controls are: Observation points, Cross
sections and Profiles.
This tutorial illustrates how to incorporate the output controls in a model using the QGIS interface.
The procedure includes the following steps:

1. Open an existing RiverFlow2D project.

2. Create ObservationPoints, CrossSections and Profiles layers, and draw the output controls.

3. Generate the mesh.

4. Running the model.

5. Review output files.

The files required to follow this tutorial can be extracted from the ‘ExampleProjects’ zip file under the
‘OutControlTutorial’ folder. This zip file is downloaded separately from your installation materials.

17.1 Open an existing project
1. Open QGIS

2. On the Project menu click Open… and browse to the existing project: ‘OutControlTutorial.qgz’.

This project contains the layers of the domain outline, the Digital Elevation Model DEM of the
river bed in raster format, the layer with the boundary conditions where inflow is located in the
upper left and outflow in the lower left. The boundary conditions are a hydrograph with a peak
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discharge of 6,500 ft3/s and outflow condition set to Free outflow. When you open the project
you will have an image of the project loaded in QGIS as shown in Figure 17.1.

Project screen loaded in QGIS.

17.2 Create a template of the layers ObservationPoints,
CrossSections and Profiles and draw the output
controls

To add the templates where the different output controls are drawn involves the following steps:

1. Create the templates of the layers ObservationPoints, CrossSections and Profiles: for this in
the RiverFlow2D toolbar click on the New Template Layer button

2. In the plugin window activate the checkBox ObservationPoints, CrossSections and Profiles,
as shown in the Figure below:
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Plugin to add the new templates layer.

3. Edit the layers and draw the output controls: Select in the layers panel, the ObservationPoints,
CrossSections and Profiles layers one by one.

4. Click on the Toggle Editing button:

A pencil will appear on the label of the layers, indicating that the layers are in edit mode:

5. Draw the lines or points that represent the output control: To draw the cross sections, profiles
or observation points, the Add Feature tool will be used.

for the CrossSections and Profiles layers, the icon for the Add Feature button is

in the case of a point layer like ObservationPoints, the icon is
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6. Drawing the cross sections: Select the CrossSection layer, and activate the Add Feature but-
ton.

7. Proceed to draw three sections: One at the beginning of the channel, another in the middle
and the third almost at the end of the channel, identify (XSECID) as: Section1, Section2 and
Section3, with intervals (ND_CS) of 10, 15 and 20 respectively. The attribute tables of the
sections will be as shown in Figure 17.3 and at the end of the drawing a similar image should
appear as shown in the following Figure 17.4.

Attribute windows for the three cross sections.

Transversal sections incorporated into the model.

8. Save the polygon by clicking the Save button and click on the Toggle Editing button



175 17. Post-processing calculations

to deactivate Edit mode on the CrossSections layer.

9. Drawing the Profile: Select the Profile layer and activate the Add Feature button, we proceed
to draw the profile along the channel central axis, identifier (PROFILEID) is Profile1 and the
number of intervals (ND_PR) equal to 50. The attribute table will be as shown in Figure 17.5.
Once finished drawing, it should appear like the one shown in the following Figure 17.6.

Attribute window for the profile.
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Profile (green line) incorporated into the model.

10. To finalize the profile drawing, save the polygon by clicking the Save button and click on

Toggle Editing button to deactivate Edit mode on the Profile layer.

11. Drawing the observation points: Select the ObservationPoints layer, and activate the Add Fea-
ture button, proceed to draw two observation points, the first between sections 1 and 2 and
the second between sections 2 and 3. As an identifier, (Obsid) is assigned Point1 and Point2
respectively. The attribute tables will be as shown in Figure 17.7 and at the end of the drawing
you should have an image similar to the one shown in the following Figure 17.8.
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Attribute windows for the two observation points.

Observation points incorporated into the model.

12. To finish the drawing of the observation points, you click again on the Toggle Editing button to
disable the editing mode of the ObservationPoints layer.

17.3 Generate the mesh
The mesh is generated with the Generate TriMesh button
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The result is a mesh of approximately 9,000 cells, as shown in Figure 17.9.

Figure 17.1 – The mesh generated.

17.3.1 Exporting files to RiverFlow2D
Now that the mesh is generated and the other layers are ready with the necessary data, export the
files in the format required by RiverFlow2D.

1. Click on the Export RiverFlow2D button

2. When run the plugin a window is displayed, select the raster layer that contains the Digital
Elevation Model (DEM) and the name of the project to be exported.
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3. Before executing the plugin, activate the layer with the DEM (if it is deactivated).

Once the plugin is executed, a window will be shown (Figure 17.10), as it should be for our
example.

Plugin to export the files to OilFlow2D for QGIS.

4. Once finished inputting the information, click the [OK] button to export the files to the model.

Once it is finished, RiverFlow2D will be loaded with the ‘base.DAT’ file.

17.4 Running the Model
After exporting the files, RiverFlow2D opens with the project file of the ‘OutControl.DAT’ sample and
shows the Control Data panel to it as illustrated in Figure 17.11.

Figure 17.2 – Control data panel.

You can observe in the control panel in Output Options the outputs of results for Cross Sections,
Profiles and Observation Points are selected.
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Leave all other parameters at their default values.

To run the model, click on the Run RiverFlow2D button. The window that RiverFlow2D presents while
running the model shows: simulation time information, volume conservation error, total discharge
of inflow in and outflow, as well as other parameters as execution progresses (Figure 17.12).

Figure 17.3 – RiverFlow2D output graphics.

17.5 Review the output files

RiverFlow2D generates the files with the extensions ‘.xseci’ (metric units) and ‘.xsece’ (English units)
which report the results along the cross sections. it generates files with extensions ‘.prfi’ (metric
units) and ‘.prfe’ (English units) which report the results along the profiles and generates the files with
the extensions ‘.outi’ (metric units) and ‘.oute’ (English units) that report the results in the observation
points.

Figure 17.13 shows an extract of the ‘OutControl.xsece’ file with results at the cross sections:
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Figure 17.4 – OutControl.xsece file.

Figure 17.14 shows an extract of the ‘OutControl.prfe’ file with the report of the profile results:
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Figure 17.5 – OutControl.prfe file.
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Figure 17.15 shows an extract of the ‘RESvsT_Point1.oute’ file with the report of the results of the
observation point Point1:

Figure 17.6 – RESvsT_Point1.oute file.
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Advanced digitization/snapping

In many cases the drawing of polygons that share borders (contiguous) is required. Trying to do
this manually usually produces polygon overlap errors, or it may generate gaps as illustrated in the
following figure:

Figure 18.1 – Areas with overlap and empty spaces in manual digitization of adjacent polygons.
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This tutorial illustrates how to use the QGIS Snapping tool to facilitate the scanning of adjacent
polygons. The procedure includes the following steps:

1. Open an existing RiverFlow2D project.

2. Activate the Snapping tool.

3. Configure the Snapping tool

4. Draw contiguous or adjacent polygons using the Snapping tool.

The files required to follow this tutorial can be extracted from the ‘ExampleProjects’ zip file under
the ‘SnappingTutorial’ folder. This zip file is downloaded separately from your installation materials.

18.1 Open an existing project
1. Open QGIS

2. In the main menu go to Project → Open… browse to the existing project: ‘SnappingTuto-
rial.qgz’.

This project contains the basic templates of a RiverFlow2D project and a raster with 4 areas with
different Manning’s n coefficients derived from land cover and land use maps. From this raster, the
polygons of the Manning N layer will be drawn. When the project is opened, a project image will be
loaded in QGIS as shown in Figure 18.2.

Figure 18.2 – Project screen loaded in QGIS.
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18.2 Activate and configure the Snapping tool
To use the Snapping tool, you must activate it beforehand:

1. Open the configuration options window: In Project menu → Snapping Options…

Project Snapping Settings window.

2. In the Project Snapping Settings window, click on the Enable Snapping button.

3. Next to the Enable Snapping button the dropdown menu for All Layers is activated. Click on
the dropdown and select Advanced Configuration.

4. In the list of layers, make sure only Manning N layer is selected.

5. Select the checkbox to Avoid Overlap on the Manning N layer.

The configuration window of the Snapping tool should be as shown in the following Figure:

Figure 18.3 – Snapping configuration panel.

18.3 Draw contiguous or adjacent polygons using the
Snapping tool

To draw the polygons with the information of the Manning’s n coefficients we proceed as follows:

1. Edit the Manning N layer: In the layers panel, select the Manning N layer

2. In the digitalization toolbar click on the Toggle Editing button

A pencil icon will appear in the Manning N layer indicating that the layer is in edit mode:
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3. Draw the polygon that demarcates the Manning’s n area: Using the Add Toggle Editing button
in the digitalization toolbar

proceed to draw the polygons. Start by drawing the polygon in the bottom of the watershed
shown in gray which corresponds to n = 0.02. After completing the drawing you should have
an image similar to the one shown in the following figure:

The first polygon sketch.

4. Proceed to draw the second polygon. This will be the small yellow polygon to which corre-
sponds to n = 0.30. To draw the polygon, follow the boundary with the green polygon as
indicated by the raster, but in the boundary with the polygon already drawn (the gray) an over-
lap will be made so that the snapping tool takes the edge that already exists and completes
the polygon. Try to make a path as shown in the figure below:

Drawn of the second polygon.
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5. Right-click to finish the drawing.

6. Enter the Manning coefficient, n = 0.30 and you will have an image like the one shown below
where you can see how the final drawing of the second polygon took the vertices of the first
adjacent polygon:

Final draw of the second polygon.

7. The third polygon to be drawn will be the large yellow polygon. Just as in the previous case,
the contour of the polygon according to the raster is faithfully followed, but in the adjacent
polygons it is already drawn overlapped. The figure below shows the initial drawing, with an
approach in the area where the overlap is made with the existing polygon:

Preliminary draw of the third polygon.

8. After finishing the drawing and assigning the Manning N umber to the polygon, the final drawing
of the third polygon will be shown as shown below:
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Final draw of the third polygon.

9. The fourth polygon to draw will be the green polygon which corresponds to n = 0.45. To do
it will follow the outer boundary of the same and the boundary with the brown polygon. Then
a thick overlap will be made within the polygon already drawn, the yellows and the gray, as
shown in the figure below:

Preliminary draw of the fourth polygon.

10. After finishing the drawing and assigning the Manning’s n value to the polygon, you will have
the final layout of the third polygon as shown below:
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Final draw of the fourth polygon.

11. To finish, draw the fifth polygon of brown color, which corresponds to n = 0.03. For this the
outer limit is drawn following the contour of the raster and for the shared limits an overlap is
made inside the neighboring polygons as shown in the figure below:

Preliminary draw of the fifth polygon.

12. After finishing the drawing and inputting the Manning coefficient to the polygon, you will have
the final drawing of the third polygon as shown below:
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Final draw of the fifth polygon.

13. To finish, click on the Toggle Editing button

changes are accepted and saved. Then the layer of the raster Manning_Map_n is deactivated,
and the Manning N vectorized layer can be observed as shown in the Figure below:

Final draw of the Manning N layer.

18.4 Delete a polygon
Suppose you want to delete the last polygon created because you are not satisfied with the result.
In that case you can proceed doing as follows:
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1. The Manning N layer is edited using the Toggle Editing button

2. Then the polygon to be eliminated is selected using the Select Feature button

3. With the active select Feature tool, click on the polygon to be deleted and it will be highlighted
in yellow to indicate that it is selected (Figure 18.15).

Polygon to be deleted selected.

4. Then the polygon is deleted either with the Delete key on the keyboard or with the Delete
selected button

Manning N layer with the polygon removed.
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5. Finally, the changes are saved and the editing mode of the layer is deactivated by clicking on
the Toggle Editing button.

This concludes the Snapping tutorial.
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Creating raster elevations from X Y Z data sets

The files required to follow this tutorial can be extracted from the ‘ExampleProjects’ zip file under
the ‘InterpolatingRasterTutorial’ folder. This zip file is downloaded separately from your installation
materials.

RiverFlow2D uses elevation data in raster format. For instance, to load an ASCII grid file, from the
Layer menu, click Add Layer, and then click Add Raster Layer… You may also click the Add Raster
Layer button:

In this example we will use elevation data available in a tab delimited X Y Z file, and create an
interpolated raster layer.

The X Y Z file can be formatted as comma, space or tab delimited data, where the first two columns
correspond to point X and Y coordinates and the third column is the point elevation Z as shown in
the following figure.
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Figure 19.1 – File containing terrain elevation points.

First, the X Y Z file is loaded to create an event layer. This can be accomplished as follows:

1. From the Layer menu, click Add Layer, and then click Add Delimited Text Layer… Alternatively,
you may also click the Add Delimited Text Layer button:

2. Open the elevations file: Click the Browse […] button and go to

‘\ExampleProjects\InterpolatingRasterTutorial\base\HohDTM_points_xyz.txt’.

3. Under File format, Comma Separated Values should be selected.

4. Under Record and Fields Options the checkboxes First row contains field names should be
selected.

5. Under Geometry Definition, click on the Z field dropdown and select z.

6. The Geometry CRS dropdown should be set to Project CRS: EPSG:2229.

The dialog should look like the following figure:
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Dialog to create a layer from delimited data text file.

7. To go to the area where the points are located, you will have to right-click on the label of the
created layer and select the option Zoom to the layer.

How to zoom a layer.

8. The points should appear in the project window:
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Layer of points created from delimited data file.

9. The raster is created interpolating from the data in the point layer. For that we will use the
Processing Toolbox to load the panel that will allow us to search for the TIN interpolation
command.

Opening the Processing Toolbox.
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Loading to the QGIS TIN interpolation tool.

10. In this window select the layer to be interpolated to create the raster, in this example we use
the point layer that we just created named HohDTM_points_METRIC. Change it by selecting
the dropdown for Vector layer.

11. We select the field that has the attribute that was used as the value to interpolate, in this case
the z field. This is done by clicking the dropdown for Interpolation Attribute, and select z.

12. Click the green + button to add the vector layer into the list.

13. Click on the Set to current map canvas extent button and it shoudl automatically fill in the extent
information.

14. In the Pixel size textboxes, enter 10. You will notice the Rows and Columns textboxes are
automatically filled in based on the pixel size.

15. Select the path to the folder where the raster layer is to be created. It is recommended to point
to the project folder directory chosen earlier in the tutorial.

The panel should look like the following figure:
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Interpolation plugin window.

16. Click OK to start the interpolation process.

Once the process is completed, the raster resulting from the interpolation will be displayed on the
screen, by default it is rendered in gray gradient as shown in Figure 19.8.
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Figure 19.2 – Digital elevation model in raster format created by interpolation.

Note: Right-clicking on the label of the created layer and selecting Properties allows you to change
the rendering style for a more informative color palette.

Figure 19.3 – Window to change the render style of a raster layer.

And now the raster layer is displayed with the new color palette selected:
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Figure 19.4 – Digital elevation model with color render.

It is convenient to move the raster layer created to the end of the list of layers, thus it does not
interfere with the display of other layers.
This concludes the Interpolating Raster tutorial.
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Setting up a Google Cloud VM for

GPU-Accelerated Simulations

This tutorial provides a step-by-step guide for setting up a powerful virtual machine (VM) on Google
Cloud Platform (GCP) equipped with an NVIDIA Tesla V100 GPU. Such a setup is ideal for running
computationally intensive RiverFlow2D or OilFlow2D simulations that can leverage GPU accelera-
tion, significantly reducing model run times.
Note: Running a VM with a GPU on Google Cloud will incur costs. Windows Server images and
GPUs are premium resources. Please review GCP pricing and ensure billing is enabled for your
project. The Google Cloud Free Trial does not typically cover GPU usage. See the official documen-
tation for more details: https://cloud.google.com/compute/docs/create-windows-server-vm-instance.
The process involves these main steps:

1. Configure and create a new Compute Engine VM instance.

2. Specify the machine type (4 vCPUs and 32 GB Memory).

3. Add and configure an NVIDIA Tesla V100 GPU.

4. Select a Windows Server boot disk.

5. Connect to the newly created VM.

20.1 Before you begin
1. You must have a Google Cloud account with a project created and billing enabled.
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2. Ensure your account has the necessary IAM permissions. At a minimum, you will need the
‘Compute Instance Admin (v1)’ and ‘Service Account User’ roles for the project.

3. Enable the Compute Engine API for your project. This can be done from the APIs & Services
dashboard in the Google Cloud Console.

4. You will need an RDP client on your local machine to connect to the Windows VM. Microsoft’s
Remote Desktop client is available for Windows, macOS, iOS, and Android.

20.1.1 Checking and Requesting GPU Quotas
By default, Google Cloud projects have a GPU quota of zero for most regions to prevent accidental
usage. Before you can create a VM with a GPU, you must request and be granted a quota for the
specific type of GPU (e.g., NVIDIA Tesla V100) in your desired region.

1. In the Google Cloud Console, navigate to IAM & Admin → Quotas.

2. In the Filter bar, select the Metric property and search for NVIDIA V100 GPUs. Select it from
the list. If it does not appear, you may need to clear the filter and first filter by Service for
Compute Engine API.

3. This view will show your current GPU quota for all regions. Most will likely be at 0.

4. Find the region where you plan to create your VM (e.g., ‘us-central1’) and select the checkbox
next to it.

5. Click the EDIT QUOTAS button at the top of the page.

6. A panel will open on the right. Enter your desired new quota limit (e.g., 1 for one V100 GPU)
and provide a brief justification for your request (e.g., “Required for running GPU-accelerated
scientific modeling software”).

7. Submit the request. Quota increase requests can take some time to be reviewed and approved
by Google. You will receive an email notification once the process is complete. You cannot
proceed with creating the VM until your quota request is approved.

20.2 Creating the VM Instance
1. In the Google Cloud Console, navigate to the Compute Engine service and select VM in-

stances.

2. Click the CREATE INSTANCE button at the top of the page. This will open the instance
creation form.

3. Name your instance: Enter a descriptive name, for example, ‘hydronia-gpu-workstation’.

4. Region and Zone: Select a region (e.g., ‘us-central1’). For the Zone, select Any (recom-
mended). This allows Google to pick an available zone, which is necessary to trigger the
quota request workflow if your quota is insufficient.
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20.3 Configuring Machine and GPU

This is the most critical step, where you define the computational resources for your VM. The fol-
lowing steps correspond to the selections shown in Figure 20.1.

1. In the main Machine configuration section, first click the GPUs button. This filters the avail-
able options to those that support graphics processors.

2. A new Graphics processing units subsection will appear. Configure it as follows:

• GPU type: Select NVIDIA V100.

• Number of GPUs: Select 1.

• Leave the Enable Virtual Workstation (NVIDIA GRID) checkbox unchecked.

3. Next, configure the CPU and memory for the VM itself:

• Series: Ensure N1 is selected.

• Machine type: Click the Custom button.

• Cores: Drag the slider or type 4 into the vCPU box.

• Memory: Drag the slider or type 32 into the GB box. Ensure the Extend Memory check-
box is active.
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Figure 20.1 – Configuring the machine with a custom N1 type, 4 vCPUs, 32 GB of memory, and one
NVIDIA V100 GPU.

20.4 Configuring the Boot Disk and Firewall
1. In the OS and Storage section, click the Change button.

2. In the fly-out menu, make the following selections:

• Operating system: Select Windows Server.

• Version: Select Windows Server 2019 Datacenter or a newer version if available.

• Boot disk type: Select SSD persistent disk for better performance.

• Size (GB): Set a size appropriate for your needs, for example, 150 GB.
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3. Click Select to confirm the boot disk configuration.

Configuring the Windows Server 2019 boot disk.

4. In the Firewall section of the main creation page, check both Allow HTTP traffic and Allow
HTTPS traffic. RDP access is enabled by default for Windows instances.

20.5 Create the VM and Handle Quota Requests

1. Review all the settings one last time. At the right side of the page, you will see a monthly cost
estimate.

2. Click the Create button.

3. If this is your first time creating a GPU-enabled VM, the creation will likely fail with a “VM
creation error” pop-up, as shown in Figure 20.3. This is expected and is the easiest way to
request the needed quota.
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VM creation error due to GPU quota.

4. Click the Request Quota button directly within the error dialog.

5. This will open the “Quota changes” request form. You will proceed in two steps:

• Step 1/2: Edit Quota (Figure 20.4)

– In the New value box, enter 1.

– In the Request description box, provide a brief justification, such as “Software re-
quires GPU to run for scientific modeling.”

– Click Done, then click Next.

• Step 2/2: Contact Details (Figure 20.5)

– Fill in your contact information.

– Click Submit request.



20.5 Create the VM and Handle Quota Requests 208

Requesting a quota increase.

Providing contact details for the quota request.

6. The quota request will be sent to Google for approval. This can take anywhere from a few
minutes to a few business days. You will receive an email once the request has been approved.
You must wait for the quota approval before you can successfully create the VM. Once
approved, return to the VM instances page in the Google Cloud Console.

7. You will see your failed instance with a red error icon. On the far right of the instance row, click
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the wrench icon to Edit and retry (Figure 20.6).

Using the Edit and retry option on a failed VM instance.

8. This will take you back to the instance creation page with all of your previous settings pre-filled.
Scroll to the bottom and click Create. The VM should now be provisioned successfully.

20.6 Connect to the VM
Once your quota request is approved and the VM has been successfully created (indicated by a
green checkmark icon on the VM instances page), you can set your password and connect.

1. Click on the name of your new VM instance to go to its details page.

2. Under the Remote access section, click the SET WINDOWS PASSWORD button.

3. A default username (your Google account username) will be shown. You can keep it or change
it. Click SET. A new password will be generated. Copy this password and store it securely.

4. You can now connect to your VM. Return to the VM instance details page, click the RDP button,
and choose Download the RDP file. Open this file with your RDP client.

5. When prompted, enter the username and the password you just copied. You are now con-
nected to your new Windows Server VM with a powerful GPU, ready for your simulation work.

This concludes the Google Cloud VM Setup tutorial.
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Creating high-impact graphics and animations

using Paraview

ParaView is an open-source, multi-platform data analysis and visualization application. You can
quickly build visualizations to analyze model results using qualitative and quantitative techniques.
The data exploration can be done interactively in 2D and 3D, or using ParaView’s batch processing
capabilities.

This tutorial will demonstrate the use of Parview to generate high quality graphics, including depth
maps, velocity fields, 3D visualizations, and animations of RiverFlow2D results.

This tutorial requires ParaView version 5.8.1 or later. You can download and install ParaView version
5.8.1 or later from the website www.paraview.org. To create the ParaView graphs, the RiverFlow2D
model needs to generate during runtime the ‘.vtk’ files using the Create graphic output files option
in the Hydronia Data Input Program Graphic Output Options panel.

21.1 Paraview basics

After loading Paraview, the following components can be identified in the main window (see Figure
21.1):
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Figure 21.1 – Main Paraview window.

To open the tutorial example group file, click in the Menu bar and double-click the file group
‘BridgeTutorial..vtk’ in the ‘ParavirewTutorial’ folder. The group contains multiple ‘.vtk’ files, where
each file corresponds to a specific simulation time.

Make it visible clicking Apply in the Properties tab. The following graphic in the Render View layout
will look as follows:

Figure 21.2 – View after opening the ’BridgeTutorial..vtk‘ file.

Using the Time control toolbar (see Figure 21.3), select a time to visualize the selected variable.
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Figure 21.3 – VCR and Time Control toolbars.

The graphic will change according with the selected simulation time. For example, for Time = 2 it
should look similar to this:

Figure 21.4 – View for Time = 2.

An adequate visualization depends on the selection of a color scale of a defined variable. In the
previous figure, the default color scale was selected associated with the depth variable (h). The next
section shows how to customize color rendering.

21.2 Two-dimensional (2D) visualizations

21.2.1 Create a 2D bed elevation map

Paraview has many filters for full visualization of 1D, 2D and 3D data. In this part of the tutorial we
will create a 2D bed elevation graphic. Select the bed elevation variable z in the Variable selector:
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Figure 21.5 – Variable selector.

The representation of the bed elevation z will look like this:

Figure 21.6 – Bed elevation z representation.

Although it is possible to customize the color maps, we will see how to do it later in this tutorial, for
this example we will use a predefined color.

Click in the Properties tab to pick up the Rainbow Desaturated color map in the Choose Preset
dialog box. Once selected, Apply/Close.
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Figure 21.7 – Predefined color maps.

The result graph visualizes of the bed elevation z.

Figure 21.8 – Bed elevation z representation.

21.2.2 Creating 2D velocity vector fields

In order to create a 2D visualization of the flow and its magnitude with our project data, we will start
with a water depth h representation in a white-to-blue color scale. The first step is to select h in
the Variable selector. To change the color map for water depth h to a white-to-blue, click and
choose the XRay preset color then Apply/Close. The Mapping Data should look as:
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Figure 21.9 – XRay Color Map.

Double click in the right circle of the range marker bar and select any blue color from the Select
Color dialog box. This example uses Red = 0, Green = 85 and Blue = 255 and Click OK

Figure 21.10 – White-to-blue color map.

The Mapping Data will look as follows:
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Figure 21.11 – White-to-blue color map.

Set the Time = 20 and the result should look as follows:

Figure 21.12 – Water depth (h).

To create a 2D velocity vector map for this example, follow these steps:

• Select BridgeTutorial* in the Pipelines Browser

• In the Filters menu select Common/Glyph

• Click Apply in the Properties panel. You will adjust the big arrows after

• Configure the Vector field configuration in the Properties panel as follows:
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– Glyph type: 2D Glyph

– Scale Array: modU (velocity modulus)

– Scale Factor: 35

– Glyph mode: Every Nth Point

– Click Apply to visualize the the filter setup. The user can press this button each time
changes are made

– Coloring: modU

• Choose the Rainbow Desaturated color scale clicking in and Apply/Close.

Figure 21.13 – Velocity vector field on water depth.
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Figure 21.14 – Velocity vector field detail.

In order to save the Paraview project, select File/Save State. This will save a ‘.pvsm’ file.

21.3 Three-dimensional (3D) visualizations

In this part of the tutorial we will explain the steps to create a 3D visualization using Paraview. We
start where section 21.2 ends. This assumes that we have a visualization of the bed elevation (z)
variable using the Rainbow Desaturated color map.

Open the ‘BridgeTutorial..vtk’ group as explained in section 21.1 and select the bed elevation vari-
able z in the Variable selector. The render view should look as the following figure:
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Figure 21.15 – Bed elevation z.

Generating a 3D visualization in ParaView requires an interpolation from Cell Data to Node Data as
follows.

• Select Cell Data to Point Data in the Filters/Alphabetical menu. Then, press the Apply button
in the Properties tab.

Cell Data to Point Data filter.

• Select again z in the Variable selector. Note that the color view is smoother due to the inter-
polation. The result should look as follows:
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Cell Data to Point Data interpolation.

The 3D appearance is obtained by extruding one of the data variables z or (h+z).

• With the CellDatatoPoint selected in the Pipeline Browser, select Warp by Scalar in the Filter-
s/Alphabetical menu to do the extrusion and then click Apply.

• Configure the Properties tab as follows:

– Scalars = z

– Scale Factor = 25

• Click Apply.

• Choose z in the Variable selector.
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Wrap By Scalar filter.

• Switch from 2D to 3D visualization in the Layout Render view to manipulate the project in 3D.

3D option.

• Remove the color map of the bed elevation z by selecting Solid Color in the Coloring drop-down
menu of the Properties tab:

Coloring parameter.

• The Solid Color can be customized clicking the Edit color map icon in the Properties
tab. Once the desired color has been chosen at the Pick Solid Color tab (this example uses
HTML=#ecb57d), the Render view should look as:
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3D bed elevation representation.

To view the terrain from different points, use the left mouse button to rotate, press down the mouse
wheel to translate, and scroll the mouse wheel to zoom in or out the image.

Using the Viewpoint Toolbar (Figure 21.22), you can add different view points of your graphic clicking
.

Figure 21.16 – Viewpoint Toolbar.

The following image was generated using an alternative view point.
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Figure 21.17 – Alternative 3D bed elevation representation.

To return to prearranged views use the Camara control toolbar.

Figure 21.18 – Camara Control Toolbar.

A more sophisticated visualization can include additional layers. In the next section we will add two
more layers: the water elevation (h+z) and the velocity vector field.

21.3.1 Create a 3D water elevation graphic adding a (h+z) layer
Follow the following steps to create the (h+z) layer:

• Click on the CellDataToPointData item in the Pipeline Browser and select Warp by Scalar in
Filter/Alphabetical. A WrapByScalar2 item will be created in the Pipeline Browser.

• Select a time ̸= 0 in the Time control toolbar, e.g.

• Configure the Properties panel as follows:

– Scalars = (h+z)

– Scale factor = 25 (very important)

• Click the Apply button. Check that h is in the Variable selector.

• Click and choose the Rainbow Desaturated color map, then Apply/Close.
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The resulting Render view should look similar to:

Figure 21.19 – Water surface elevation representation.

As seen in this figure, the layers corresponding to z and (h+z) variables are overlapped in the dry
areas of the domain, generating a confusing presentation. One easy way to fix this issue is to
remove the water depth h values below a user-defined value to avoid overlapping, doing as follows:

• Click WrapbyScalar2 in the Pipeline Browser and select Threshold in Filter/Common in the
main menu

• Click Apply in the Properties panel, and check that h is in the Variable selector.

• Set the minimum value equal to 0.01 m. Depths (h) below this minimum will not appear in the
color representation.

• Click Apply and the result should be as follows:
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Figure 21.20 – Threshold Filter application.

With the Threshold layer selected, change the color map for water depth h to a white-to-blue as it
was explained in Section 21.2.2 of this tutorial. The result graph should look as follows:

Figure 21.21 – Three dimensional water depth h representation.

21.3.2 Create a velocity field graphic
Follow the following steps to create a velocity field graphic:

• Select the Threshold item in thePipeline Browser.

• In the Filters menu select Common/Glyph and click the Apply.
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• Configure the Properties panel as follows:

– Glyph type = 2D Glyph

– Orientation Array = velocity

– Scale Array = modU (velocity modulus)

– Scale Factor = 25

– Glyph mode = Every Nth Point (to prevent a saturation of arrows in the visualization)

– Click the Apply button to visualize immediately the filter setup, the user can press this
button after each of the previous steps

– Set Coloring as (modU) for the color map representation and choose the preset color
Rainbow desaturated then Apply/Close

• Select Time ̸= 0 as the current time control tool bar. In this example chose for instance Time=3.

After these steps, the graphic should look like this one:
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Figure 21.22 – Three-dimensional velocity field representation.

In order to save this Paraview project select File/Save State and create a ‘.pvsm’ file. To load any of
the saved projects select emphFile/Load State and select a ‘.pvsm’ file.

21.4 Generating animations
With your Paraview project loaded in your computer to create an animation or movie go to File/Save
Animation and create a file type ‘.avi’. The Save Animation Options dialog will be displayed:

Figure 21.23 – Animation.

In this dialog, the user can configure the video frame rate, the number of frames per time step, the
resolution (in pixels) and the range of time steps. In order to reduce the size of the output video file,
a compression mode is also available for the video. Note that this will also reduce the video quality
of the animation. As an example, the next figures show three frames of the output video generated
in this way, corresponding to six different simulation times.
Animation time frames.
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21.5 Steamlines representation

Streamlines represent the instantaneous direction of the velocity and is drawn as unending lines
that may converge or diverge from one another. They are drawn at roughly even intervals to capture
the flow in all areas.

To create Streamlines with Paraview, follow these steps:

• Open the Paraview application in your computer

• Load the plugin StreamLinesRepresentation in Tools/Manage Plugins in the main menu

• Open the ‘BridgeTutorial..vtk’ Group file and Select Apply

• Select a time different than 0 in the time control tool bar

• Select velocity in the Variable selector

• In the Properties panel select:

– Representation = StreamLines

– Step Length = 1

– Number of Particles = 1000

– Max Time to Live = 600

• To have Streamlines in one color, select in the Property panel Coloring = Solid and then click
on and select a color.

The next figure shows how the StreamLines look:
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Figure 21.24 – StreamLines representation.

If you load a Paraview project ‘.pvsm’ file, you have to deactivate the filters in the Pipeline Browser
by clicking the open eyes so that only the ‘*.vtk’ file layer is open.
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